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BÀI TẬP 1. GIỚI TIHỆU MICROSOFT ACCESS

1.1 Access là gì?

Microsoft Access là một Hệ quản trị cơ sở dừ liệu (HQTCSDL) dạng quan hệ. Ở
mức độ cơ sở, HQTCSDL là một chương trình cho phép lưu trữ và truy cập tới các thông
tin có cấu trúc. Các công cụ của chương trình cũng cho phép thực hiện các thao tác với 
dữ liệu như chèn, xoá và tìm kiếm dử liệu. Mục tiêu hàng đầu của một HQTCSDL là tạo 
điều kiện thuận lợi nhất cho người sử dụng trong việc lưu trữ, cập nhật và truy cập dừ 
liệu mà không nhất thiết phải biết chính xác cấu trúc vật lý của cơ sở dữ liệu.

1.1.1 Các đặc tính của Access

MS Access là tập hợp của các yếu tố sau:

• Một cơ sở dữ liệu quan hệ hồ trợ hai ngôn ngữ tra vấn chuẩn là ngôn ngữ tra vấn 
có cấu trúc (Structured Query Language, viết tắt là SQL) và ngôn ngữ tra vấn 
bằng ví dụ (Query By Example, viết tắt là QBE);

• Một ngôn ngữ lập trình được xác định như một tập con của ngôn ngữ Visual 
Basic;

• Một ngôn ngữ macro;

• Một môi trường phát triển ứng dụng bao gồm các công cụ tạo lập biểu mầu và
báo biêu;

• Một số ứng dụng mở rộng dạng hướng đối tượng; và

• Các công cụ dạng thuật đồ và xây dựng ứng dụng.

Đối với những người mới làm quen với ACCESS, cấu trúc đa dạng của phần mềm 
này có thể làm cho họ cảm thấy khó xử. Đó là do các yếu tố của ACCESS dược xây dựng 
trên cơ sở các các giả thiết ban đầu và những quan điểm tính toán khác biệt. Chẳng hạn 
như:

• Đặc tính của một cơ sở dừ liệu quan hệ đòi hỏi người sử dụng phải hiển thị ứng 
dụng của mình dưới dạng các tệp dữ liệu;

• Đặc tính của một chương trình được viết bời một ngôn ngữ lập trình đòi hỏi người 
sử dụng phải hiển thị ứng dụng của mình dưới dạng các lệnh được thực hiện theo 
một trình tự nào đó;

• Đặc tính hướng đổi tượng đòi hỏi người sử dụng phải hiển thị ứng dụng của mình 
dưới dạng các đối tượng bao hàm các thông túi về trạng thái và ứng xử.

Microsoft không tạo điều kiện cho việc tích hợp lôgic các đặc tính khác biệt này 
(hay nói đúng hơn, khả năng tích hợp này là không hiện thực). Thay vào dó, người sử 
dụng được quyền tuỳ ý lựa chọn cách tiếp cận tối ưu trong việc xây dựng và thực hiện 
ứng dụng của mình.

Do có rất nhiều cách khác nhau để thực hiện mỗi đặc tính của ACCESS, việc 
nhận biết các thành phần của ACCESS và khai thác tối đa các tính chất của mỗi thành 
phần đó là kỹ năng quan trọng của những người phát triển ứng dụng trên ACCESS.
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1.1.2 Bên trong một tệp cơ sở dữ liệu của Access có gì?

Mặc dù bản thân thuật ngừ “cơ sở dữ liệu” đã chứa đựng hàm ý về một tập hợp 
các bảng dữ liệu có quan hệ với nhau, một cơ sở dữ liệu của ACCES chứa đựng nhiều 
hơn các dữ liệu. Ngoài các bảng ra, trong một cơ sở dữ liệu ACCESS còn bao gồm một 
vài dạng đối tượng cơ sở dữ liệu khác, đó là:

• Các tra vấn được cất giữ để tổ chức dữ liệu,

• Các biểu mẫu để tương tác với dữ liệu trên màn hình,

• Các báo biểu để in ra các kết quả,

• Các chương trình macro và các chương trình viết trên Visual Basic để mở rộng
chức năng của các ứng dụng cơ sở dữ liệu.

Tất cả các đối tượng nêu trên được lưu trong một tệp đơn lẻ được đặt tên là : 
<Tên tệp>.Mdb.

1.2 Thực hành

Trong phần thực hành này, bạn sẽ bắt đầu bằng việc tạo một tệp cơ sở dữ liệu
mới.

1.2.1 Khỏi động Access

Để khởi động Access, kích đúp trỏ chuột lên biểu tượng Access trên màn hình 
máy tính hoặc vào Start- > Programs- > Microsoft Accès.

1.2.2 Tạo một cơ sở dữ liệu mới

Thực hiện theo hướng dẫn trên Hình 1.1 để tạo một tệp cơ sở dữ liệu mới có tên là 
CruiseRepo rt. mdb
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Hình 1.1: Đặt tên và trỏ đường dẫn cho cơ sở dữ liệu mới tạo.

Bưởcl. Tạo một cơ sở dữ liệu mới bằng cách chọn New từ Lệnh đơn File hoặc kích trỏ 
chuột vào phím "New" trên thanh công cụ.

Bước 2. Từ mục "New" ở bên phải màn hình, chọn Blank Database để tạo một cơ sở dừ 
liệu rỗng. Chú ý rằng hiện đã có một số cơ sở dữ liệu được tạo trên Access và có thể 
được truy cập từ lựa chọn "Open aỷile".

Bước 3. Gõ tên của cơ sở dữ liệu mới tạo và nhấn Enter.
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File £dit ỵiew Insert Tools Window Help *
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Hình 1.2: Cửa sổ database chửa tất cả các đối tượng của cơ sở dữ liệu phục vụ cho
một ứng dụng.

Bạn hãy nghiên cứu kỳ các thành phần của cửa sổ cơ sở dừ liệu, đặc biệt là các 
tab dùng để hiển thị các đối tượng khác nhau của cơ sở dữ liệu như minh họa trên Hình 
1.2.

• Tables (Bảng): chứa dừ liệu ờ dạng các hàng và các cột.

• Queries (Tra vấn): cho phép thực hiện các thao tác sắp xếp, lọc và hiển thị dữ liệu 
chứa trong các bảng bằng nhiều cách khác nhau.

• Forms (Biểu mẫu): dùng để hiển thị thông tin trên màn hình máy tính.

• Reports (Báo biểu): dùng để tổ chức và in ấn thông tin.

• Pages (Các trang chứa dữ liệu của ACCESS): là các trang Web dạng đặc biệt 
được thiết kế để hiển thị và làm việc với dừ liệu trên Internet.

• Macros (Các lệnh Macro): là tập hợp các lệnh cấp cao dùng để xử lý dữ liệu và 
thực hiện các nhiệm vụ lặp đi lặp lại.

• Modules (Các đơn thể chương trình): chứa các chương trình con và hàm viết trên 
Visual Basic.

12.3  Mở một cơ sở dữ liệu cố sẵn

Để mở một cơ sở dữ liệu đã có sẵn, bạn phải nhắp chuột chọn một cơ sở dữ liệu 
Access mẫu. Trong bài tập này ta sẽ mở tệp có tên gọi là Fpnwind.mdb.
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Mở cơ sở dừ liệu nằm trong Program Files/Microsoft Office/Office!0/1033 và 
chọn tệp Fpnwind.mdb và kiểm tra nội dung của bảng Customers, như minh họa trên 
Hình 1.3.
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DRACO Drachenolut Delikatessen Sven Ottlieb Order Administrator Walserweg 21
OUMON Du monde entier Janite Labrune Owner 67, -ue je s  Cinquanie Plages______________
EÄSTC Eastern Connection Ann Dovon Sales Agent 35 King George
ERNSH Ernst Handel Rolcnd Mendel Sales Manager Kirchgasse 6
FAMIA Farr iia Arqu baldo Ar a Cruz Marketing Assistant Rúa Oros. 92
FISSA FISSAFabrica Inter Salchichas S A Díeto Roe Accounting Manager CỈ Moralzarzal, 86
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Hình 1.3: Mở tệp Fpmvind.mdb rồi mở bảng Customer.

Bước 1. Chọn Open từ Lệnh đơn File hoặc chọn More Files... từ mục Open a file ở bên 
phải màn hình.

Bước 2. Chọn tệp Fpnwind.mdb và mở bảng Customer.

Bạn có thể mở một đối tượng của cơ sở dữ liệu để hiển thị, chỉnh sừa hay tạo mới 
một đối tượng.

1.2.4 Xem trợ giúp

Access dựa rất nhiều vào các tài liệu hướng dẫn và trợ giúp trực tuyến thay vì các 
tài liệu in trên giấy. Thông thường, kiến thức về việc sử dụng trợ giúp trực tuyến sẽ giúp 
ích rất nhiều cho việc nghiên cứu một phần mềm mới. Trong mục này, bạn sẽ sử dụng trợ 
giúp trực tuyến của Access để thực hiện thao tác nén một cơ sở dữ liệu.

Chọn Help>Microsoft Access Help để kích hoạt hệ thống trợ giúp trực tuyến. Đe 
tìm trợ giúp về việc nén cơ sở dữ liệu, hãy gõ từ khoá compact vào hộp thoại như minh 
họa trên ffinh 1.4.
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Microsoft Access Help

Contents I Answer Wizard Index 

1. Type keywords

Đ ® ®

ịrepair;

Clear Search

2. Or choose keywords

access /S

activate
add-in
addition
administrator
advance
aggregate V

3. Choose a  topic (52 found)

1 Correct handwriting A

1 Automatically repair office programs
Compact and repair an Access file 1
Correct speech recognition errors 
Turn on or off AutoCorrect options 
About compacting and repairing an Access 
Troubleshoot handwriting recognition in Ea 
Improve perform ance of an  Access da taba  
Troubleshoot the  Upsizing Wizard 
Undo changes
About getting help on SQL Server
Work with d a ta  in Page view
About creating a  field th a t looks up or lists
About Microsoft Office XP Proofing Tools
Troubleshoot sort
Troubleshoot queries
Edit an existing relationship

▼ Show All

Compact and repair 
an Access file
To ensure optimal performance, 
you should compact and repair 
your Microsoft Access files on a 
regular basis. Also, if a  serious 
problem occurs while you are 
working in an  Access file and 
Access a ttem pts to  recover it, 
you might receive a  m essage 
th a t the  repair operation was 
cancelled and th a t you should 
compact and repair th e  file.

You must have Open/Run and 
O pen Exclusive permissions for 
an  Access d a tab ase  in order to 
compact and repair it.

► Compact and repair the  
current Access file

► Compact and repair an 
Access file th a t is not open

► Compact and repair an 
Access file automatically every 
time you close it

N o te  You can stop  the  
compact and repair process by 
pressing CTRL+BREAK or ESC.

Hình 1.4: Sử dụng hệ thống trợ giúp để tìm thông tin về một chủ đề chuyên biệt.

Bưác 1. Gõ vài chữ đầu tiên bằng tiếng Anh biểu thị chủ đề mà bạn đang tìm.

Bước 2. Chọn chủ đề phù hợp nhất từ danh mục (chẳng hạn, "Compact and repaừ an 
Access file").

Bước 3. Nội dung chi tiết về chủ đề được hiển thị ở phần bên phải của màn hình trợ giúp.

Mục Index là nơi tốt nhất để bắt đầu nếu bạn muốn tìm một chủ đề nào đó. Nếu 
bạn muốn tìm hiểu một thông tin có cấu trúc hon hoặc tổng quan hơn, hãy sử dụng tab 
Contents. Chú ý một số điểm sau đây:

• Thay vì đóng trợ giúp trực tuyến, hãy cực tiểu hoá màn hình trợ giúp trong khi 
đang làm việc với cơ sở dữ liệu. Như vậy bạn sẽ luôn luôn có thể sử dụng phím 
Back để quay trờ lại các chủ đề đã tham khảo trước đó mà không cần lặp lại quá 
trình tìm kiếm.

• Nhừn« cụm từ được gạch dưới sẽ được giải thích bằng các định nghĩa quan trọng 
với môi liên kêt tới các trang trợ giúp khác.
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1.2.5 Nén cơ sở  dữ liệu

Thực hiện các bước theo hướng dẫn trong cửa sổ trợ giúp trực tuyến minh hoạ 
trên Hình 1.4 để nén cơ sờ dữ liệu của bạn.

1.3 Thảo luận

1.3.1 Tệp cơ sở dữ liệu trong Access

Thuật ngữ "cơ sở dữ liệu " biểu thị những ý nghĩa khác nhau tuỳ thuộc vào Hệ 
quản trị dữ liệu được sử dụng.

Chẳng hạn, trong dBase IV, một cơ sở dừ liệu là một tệp (<tên têpxdbf) chỉ chứa 
một bảng duy nhất. Các biểu mẫu và báo biểu được lưu giữ như các tệp đơn lẻ khác dưới 
dạng các tên tệp có phần mở rộng khác. Kết quả cuối cùng là một tập hợp các tệp.

Ngược lại, trong một cơ sờ dữ liệu Oracle, không có mối quan hệ nào tồn tại giữa 
các tệp đơn lè hay các dự án. Chẳng hạn, một cơ sở dử liệu có thể bao gồm nhiều bàng từ 
các dự án hay ứng dụng khác nhau và có thể được lưu giữ rải rác trong một hay nhiều tệp 
khác nhau (có thể trên nhiều máy khác nhau).

v ề  mặt này, Access có ưu điểm ờ chỗ nó gộp tất cả các "đối tượng" (bảng, tra 
vấn, biểu mẫu, báo biểu, v.v...) của một dự án hay một ứng dụng đơn lẻ chỉ trong một 
tệp.

1.3.2 Nén một cơ sở dữ liệu

Theo trợ giúp trực tuyến, các tệp cơ sở dữ liệu Access có thể trở nên rất lớn do 
khối lượng dừ liệu chứa bên trong nó. Quá trình nén cơ sở dữ liệu định kỳ theo thời gian 
sẽ loại trừ được sự phân đoạn tệp và giảm bớt đáng kể đòi hỏi về không gian lưu trừ dữ 
liệu trên đĩa cho cơ sờ dừ liệu cùa bạn.

1.3.3 Phất triên các úng dụng trên Access

Nhìn chung, có hai cách tiếp cận để phát triển các hệ thông tin:

• Phân tích chi tiết hệ thống trước khi thiết kế và xây dựng;

• Xây dựng nhanh dựa trên một khuôn mẫu có sẵn (trong đó việc phân tích, thiết kế 
và xây dụng được thực hiện lặp đi lặp lại).

Access cung cấp một loạt các công cụ (chẳng hạn như các công cụ thiết kế đồ 
hoạ, các thuật đồ, và một ngôn ngữ macro bậc cao) cho phép áp dụng cách tiếp cận thứ 
hai.

Các bài thực hành tiếp theo sẽ hướng dẫn các bạn xây dựng một cơ sở dữ liệu 
nhỏ, áp dụng cách tiếp cận xây dụng nhanh theo khuôn mẫu. Quy trình phát triển ứng 
dụng sẽ được thực hiện qua các bước chính sau đây:

1. Lập mô hình thông tin quan tâm dưới dạng các thực thể và mối quan hệ giữa các thực 
thể;

2. ứng với mỗi thực thể ta tạo một bảng (Bài thực hành 2).

3. Xác lập quan hệ giữa các bảng (Bài thực hành 3).
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4. Tổ chức thông tin trong các bảng, sử dụng các tra vấn (Các bài thực hành 4 và 5)

5. Tạo các biểu mẫu chính và biểu mẫu phụ để hồ trợ việc nhập và kết xuất dữ liệu (Các 
bài thực hành 6 và 7).
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Bài tập 2. Làm việc vói các bảng

2.1 Thiết kế bảng

Trong mục này, bạn sẽ học cách làm việc với các bảng đã có sẵn và thiết kế các 
bảng mới.

Bỏ thêm một chút thời gian suy nghĩ cho việc thiết kế bảng sẽ có thể tiết kiệm 
được cho bạn rất nhiều thời gian trong những bước tiếp theo của quy trình xây dựng cơ 
sở dữ liệu. Khi khuôn khổ và độ phức tạp của ứng dụng của bạn càng lớn thì việc sửa đổi 
các bảng và mối quan hệ giữa chúng càng trờ nên khó khăn hon.

2.1.1 Cơ sở về Bản dữ liệu

Các thành phần quan trọng của một bảng được hiển thị dưới dạng Bản dữ liệu 
được minh họa trên Hình 2.1.

T it M icrosoft A ccess

File Edit View Ịn ĩen  Format Records Took Window l-elp

- u tì & a  ? # t 9.1 h ^ n H M I* © &.: ©.
IJUU1

88 Station : Tabl«
STATION IDl CRUISE ID I STATION NO OATE DEPTH 1 LA’  1 LONG | WEATHER W1NO CM» 1 WIND SPEEO TEMP DP -

► 0 11 1 A9flS96 940] -28 85 160.6167 SW 155] 2
2 1 2 1/29/1990 1510 •29.1333 161 55 MS 125 5
3 ____1 3 ____ 1/30/19» 1C70 -27.5 153.0811 SHOWER -903 0
i 1 4 1/30Ă998 1220: Í 6  as 163.6^44 RAIN -999 0
5 1 5 1/30fl990 2C00 -35.2526 162.5972 UnRec 45 2 —J
6 1 B 1/20/1598 2400 -25.6583 163.46B7 RAiN 135 5
7 117 1/31 (ỊS98 2660 •24 6417 1634667 OC •999 0
0 1 0 2/inS©0 1200 -24.0936 161.6222 CLOUDY 103 2
9 1 9 2^/1998 7C6Ũ -25.6 161.1556 OC 270 2

in 1 10 ?/4/1 SS8 4960 •23 2583 160 3833 MS U 3 2
11 1 11 28/1900 4370 -25.9776 159.6389 SHOWER 93 10
12 1 12 2/5/1998 4260 -27.6957 159.5657 MS 45 7
13 1 13 2/6AS88 4Ễ20 /6A25 157.9167 MS 122 9
14 1 14 2ffl1S0B •leoa -26.1 158.7167 CLOUDY 89 13
15 1 15 2/7fiS08 4260 -25.25 159.5333 MS 115 9
16 i  I6 2/an 998 3370 -2d 66 160.3333 MS 356 3
17 1Ỉ17 2firt998 1660 •24 0553 161.1333 CLOUD V 200] 4
10 1 18 2flrt908 1400 •23.5933 16D.C851 CLOUDY 135 4
19 1 19 2/9rtS98 2500 -24 1333 150 25 SR 312 25
20' 1 20 2/10/1 see 4220 ■24.041 / 158.4167 MS 145; 12
21 1 21 2/11^990 3660 -25 225 157.625 SR -999 0
22 1 22 2/11/1908 3800 -24 157.6333 MS 133 8
23 12 3 2/13*988 96 1 •28 6333 159.2667 CLOUD V 170 3
24 1 24 2/13^990 2300 *27.4833 155.6417 CLOUDY 222 5
25 1 25 2/13/1908 2340 -26.GB3? 155.6333 OC 270 3
26 1 25 2/14/1998 3740 26 8333 158 4667 OC 300] 2
27 1 27 2/15/1S90 3660 -24.0333 155.6417 OC 270 11
28 1Ị 20 215rtSG8 5200 -24.1957 156 65 SR 212 7
29 ĨÌ29 2/16^1998 430Õ 24 1S33 166 5  CLOUD r 993 0
•in 1 iT i •T fircm IfftFK Vi' OO 1/K 1.1

. r1 R3CCÍƠ: __ 1 I ► 1 M I M  cf 157 V 1

i i  s tart  c  ^pccuw rti aná Se utseRapart: L it a t . a  Sts*«*!: ~d>c

Hình 2.1: Một bảng được hiển thị dưới dạng bản dữ liệu.

Các tên trường được hiển thị ở hàng trên cùng, trên đỉnh của các cột. 

Các thanh ghi được hiển thị dưới dạng các hàng.
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• Dấu sao (*) đánh dấu một chỗ trống để nhập vào một thanh ghi mới. Các ô vuông
màu xám nằm trên hàng dọc ngoài cùng bên trái là các công cụ dùng để chọn các
thanh ghi.

• Tam giác màu đen chi vị trí của thanh ghi hiện đang được xét.

• Các phím ở phía dưới cửa sổ cho thấy số thứ tự của thanh ghi hiện tại và cho phép
người sử dụng truy cập trực tiếp tới thanh ghi đầu tiên, thanh ghi trước, thanh ghi 
tiếp theo, thanh ghi cuối cùng hay thanh ghi mới.

• Bạn có thể sắp xếp các thanh ghi theo một thứ tự nào đó bằng cách nhấn chuột
phải tại vị trí của một tên trường bất kỳ của bảng.

• Bạn có thể hiệu chỉnh kích thước của một cột bằng cách kích trỏ chuột lên đường 
viền của cột đó và kéo trỏ chuột sang phải.

2.1.2 Tạo một bảng mới

Trong mục này bạn sẽ tạo khung cho một bảng mới và cất giữ nó dưới tên gọi 
Cruise (Chuyến khảo sát). Bảng này được sử dụng để chứa các thông tin liên quan tới các
chuyến khảo sát môi trường biển.

Bước 1. Mở cơ sở dữ liệu CruiseReport và tạo một bảng mới như minh họa trên Hình
2.2

Tjé M icroso ft Access P1IE1W

File Edit View Insert Took Window Help *

D  H i  . B *  ! if&  * ¡5 * >  Ẽ * (5 .

¿ã C rulseReport : Database (Access 2000 file  format)

i^ O p o n  &£ Design New e o Vi'

Objects 1  ■ ' lr r^-tir.n vs»

(HD Tables @ j Create table by using wizard

áỊ? Queries
0 ]  Create table by entering data

m Forms

B  Reports

*■1 Pages

ữ  Macros

«*£ Modules

Groups

»1 Favorites

Hình 2.2: Tạo một bảng mới.
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• Chọn phím Tables nằm dưới mục Objects để tạo một bảng mới.
• Kích đúp trỏ chuột vào mục Create table in Design View (Tạo bảng ở dạng Thiết 

kế).

Bước 2. Trong cửa sổ dạng thiết kể  như minh họa trên Hình 2.3, gõ các thông tin sau vào:

Field name Data type Field Size Description (tuỳ chọn)
CRUISEJD Number Integer Chỉ sô duy nhât
PROJECT_NAME Text 40 Tên chuyên Dự án
INSTITUTE Text 40 Tên cơ quan
VESSEL Text 15 Tên tàu nghiên cứu
START_DATE Date/Time Ngày băt đâu khảo sát
ENDJDATE Date/Time Ngày kêt thúc khảo sát
AREA Text 50 Vùng địa lý
CHIEF_SCIENTIST Text 20 Khoa học trưởng
REMARKS Text 50 Ghi chú

Fite £dil ỵiíxv Ịr«wr Toete W in« '»

□ - H te * Ife B** <3.

■
K

PíMName ữ d teĩvo i 1 C'SiCrb’jOU 1
f tin te ' Lttque id

PeCÜEOLNWE Text Nans of 'Jwcu6*
lHStĩỉUTE T o t Wane of «»earth iwtlute
VESSEL T&Ị

DüteflRK
Wane ol ftaM fdivw id

STÍRT DATE 9 ra t lists Íù rth íữ usớ
ỮX>_DÃTE CelefT IIW 6 lJ  Jalv lor li e  t r ữ «
«?EÃ Vest
c n : ĩ= jc E w n s r Tv A
REMARKS Text

—1

G»«"* I lO*).P I 
F M  5 »
Format 
Oectoairt»:« 
IrpJ: Mask 
Capital 
0ef«ukV4ue 
VsMwon Kae 
VaWàtian Twt 
a« |jr8d  
trxtexed

AIWü rèflwCefiUnjpU>é4Cl'«TdCle»ik>n8, rduû io  ipecwi D'trSiF] for hetp un M Jfânes.

t e tP H îA , Ft = aanei. Fl = rti

3 | &3«332. ACCES. á ã  CnMsÀeport csa

Hình 2.3: Nhập các tính chất của các trường cho bảng Cruise.

• Cột Description cho phép bạn nhập vào một mô tả giải thích cho trường hiện tại 
(thông tin này không được xử lý bởi Access). Đe gõ mô tả bằng tiếng Việt, máy 
tính của bạn phải được cài đặt phần mềm VietKey 2000 và chọn phông chừ
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Unicode. Trong trường hợp ngược lại, bạn hãy gõ phần mô tả bằng tiếng Việt 
không dấu.

• Gõ tên và xác lập loại dữ liệu cho tất cả các trường. Chú ý rằng các tên trường 
được nhập vào bằng tiếng Anh, còn việc hiển thị các tên trường bằng tiếng Việt 
có thể được thực hiện bằng cách gõ tên trường tương ứng bằng tiếng Việt vào 
mục “Caption”

• Mục Field Properties cho phép bạn gõ vào các thông tin về một trường và những 
hạn chế đối với các giá trị sẽ được nhập vào trường này.

Bước 3. Chọn Save từ lệnh đơn File (hay nhấn Control-S) và cất giữ bảng dưới tên gọi 
Cruise.

Bước 4. Tạo các bảng mới Station (Trạm đo) và Observation (Quan trắc) sử dụng các số 
liệu sau:

Bảng Station.

Field name Data type Field Size Description (tuỳ chọn)
STATION ID Number Integer Chỉ sô duy nhât
CRUISE_ID Number Integer Mã chuyên khảo sát
STATION_NO Text 50 Sô của trạm đo
DATE Date/Time Ngày quan trăc
DEPTH Number Integer Đô sâu cưc đai
LAT Number Double Vĩ đô tram đo
LONG Number Double Kinh độ trạm đo
WEATHER Text 30 Thừi tiêt
WIND_DIR Number Long Integer Hướng gió
WIND SPEED Number Long Integer Vận tôc gió
TEMP_DRY Number Long Integer Nhiệt độ phao khô
TEMPJWET Number Long Integer Nhiệt độ phao uớt
AIRJPRESSURE Number Long Integer p suât không khí
CLOUDY Text 25 Độ mây
TRANSPARENCY Text 5 Độ trong của nước

Bảng Observation.

Field name Data type Field Size Description (Tuỳ chọn)
OBSERVATIONJD Number Integer Chi sô duy nhât
STATIONJD Number Integer Sô của tram đo
TIME Text 50 Thời gian quan trăc
DEPTH Number Double Độ sâu quan trăc
TEMPERATURE Number Double Nhiệt độ
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SALINITY Number Double Đô muôi
SIGMA_T Number Double Sigma_T
OXYGEN Date/Time Double 0  xy
PHOSPHATE Number Double Phôt phát
NITRATE Number Double Ni tơ rát
SILICATE Number Double Si li cát
PH Number Double pH

2.1.3 Xác lập khóa chính

Thông thường, mồi bảng có khả năng có một khoá chính cho phép xác định tính 
duy nhất của các thanh ghi chứa trong bảng. Khi bạn gán cho một trường vai trò khoá 
chính của bảng, Access sẽ không cho phép bạn nhập các giá trị trùng lặp vào trường đó.

Bạn hãy xác lập khoá chính của bảng cho trường CRUISE_ID như minh họa trên 
Hình 2.4.'

EE2
fjlo Edit yw»Y .riMjrt ỉo o tc  Window Help

B - H a m t- - r  ỊT]ã? & j &  O - S -

’ >
Ffcïi Mytc

L-'.JJX
?rc*:ect w e

I___B a g jff ig___I
Mjrrbir
Texl

Chi sc <ti>- rh ft (Mi chuvth ’»has 
TwiCüJài

"BOUTE Text TéfiCOQJàr-
VESSEL Text I  cri r.n  ktvio sir
STAR I DATE CotefTwc Ngày b it Í5ti chuy&) lha; ist
END DATE Date/Time Ngõ/ kẽl thúc chuyên kháo îàk
MEÃ Texl Vữq đia lý
n iE = j'. : :E K n r Te:<t Khoa nçc trưònj
RÈMÂWC5 To:<t Ghichú

Gerefd Ị loeJaip I 
Feld Sie 
Fermat
Dsanvtf Maces 
intư Mdik 
Csptnn 
DefaifcVato 
'/¿idatar. RlJe 
vddítíonTôxt 
kecM’-S 
ìnúexai

integer

Auto

M3 cfrjyéh tihão «ị* 

•tes
YeS (No Dtflcates)

i ÏÜ»A'. F6 -SrtiÂl' pj-isS. FI -

■THI' ểjíỆỀ *

Hình 2.4: Xác lập trường khoá chính cho bảng Cruise.

Kích trỏ chuột lên phím có in hình chiếc chìa khoá trên thanh công cụ hoặc chọn 
Edit > Primary Key\
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• Kích trỏ chuột lên ô vuông màu xám nằm bên trái một (hay nhiều) trường để xác 
lập khoá chính.

• Để chọn nhiều trường một lúc, bạn nhấn phím Control trong lúc dùng trỏ chuột 
kích lần lượt lên các ô vuông màu xám.

2.1.4 Xác lập các tính chất cho trường
Trong mục này, bạn sẽ xác lập một số tính chất cho trường START_DATE như 

minh họa trên Hình 2.5.

• Gõ “Ngày bắt đầu” vào mục Caption (Chú giải).

• Xác lập tính chất của một trường dừ liệu loại Ngày tháng trong mục Input Mask
(Mặt nạ nhập liệu).

2.1.5 Sử dụng thuật đồ Mặt nạ nhập liệu

Trong mục này, bạn sẽ sử dụng thuật đồ Mặt nạ nhập liệu để tạo ra quy tắc nhập 
dừ liệu cho một trường. Ngoài ra, bạn cũng sẽ sử dụng hệ thống trợ giúp để tìm hiểu kỳ 
hơn về ý nghĩa của một số ký hiệu được sử dụng trong Access để tạo ra các mặt nạ nhập 
liệu.

Khởi động thuật đồ Mặt nạ nhập liệu (Input Mask Wizard) như minh họa trên 
Hình 2.6. Các mặt nạ nhập liệu nhằm giúp cho người sử dụng tránh được những lỗi hay 
gặp phải trong quá trình nhập liệu mà không phải xây dựng những chương trình kiểm 
soát lỗi phức tạp. Tuy nhiên, cũng cần lưu ý rằng việc ràng buộc các trường bởi quá 
nhiều quy tắc nghiêm ngặt đôi khi cũng gây khó khăn cho người sử dụng trong quá trình 
nhập liệu.
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Hình 2.5: Xác lập các tính chất cho trường START_DATE.
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Reqjfed 
1 r<te>:ed 
]ME l>tode
JME Sifience M«te

Chi íõ diiy rhift chuyên Ihãc sát) 
Téri ữ /á r i 
Tổn co quai
rén  tâu 1*30 íá t
Ngây b ít ổão chuyên khão -H
tiọáf '<&. th i:  điuyéh *hia rít: 
vừ>3 *(3 ^
ttttă  hoc trơdnQ 
C,H ,+<j

DO you Wirt to  chirps tne hput mask*

Irp j t NaskteTO! »■Víđưn Dỉte 

Input Maifc:

VVhat pbrehoíòer ch&ocĩer do you want the firid to dipfayi 

HaceWdeis arc rsp lveda ĩ you rrttr dars iy-o th? feld 

PlaceMdef character: I"

j < E*:fc I Cfrxt > I Btefr I

A portion fOf a i data (c bo crtcicd m th« field

lrpJti*VBkw»-d

Bs*íp2_ACC£.., í ^ ị .'•Utmecia Ted... »■ CrutteReport: RS Cube TàL>ẽ K B S  « g p *  -
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Hình 2.6: Sử dụng thuật đồ Input Mask Wizard để tạo mặt nạ nhập liệu.

2.1.6 Nhập khẩu dữ liệu tie các ứng dụng khác

Access cho phép dễ dàng nhập khẩu dữ liệu từ các ứng dụng khác. Chẳng hạn, 
bạn có thể tạo một bảng mới bằng cách sử dụng dữ liệu từ một bảng Excel. Quy trình 
nhập khâu dữ liệu từ một bảng Excel vào một cơ sở dữ liệu mới được tạo bao gôm các 
bước sau:

Bước L Chọn Get External Data >Import từ lệnh đom File và truy cập tới thư mục chứa 
tệp bạn muốn nhập khẩu.

Bước 2. Chọn các tệp có dạng *.xls (các tệp dạng này sẽ được hiển thị trong cửa sổ thư 
mục).

Bước 3. Kích đúp trỏ chuột lên tệp bạn muốn nhập khẩu.

Bước 4. Sử dụng thuật đồ nhập khẩu để xác định các thông số nhập khẩu cần thiết.

2.2 Thảo luận

2.2.1 Thuật ngữ Khoá

Khoá là một hay một vài trường cho phép xác định duy nhất một thực thể biểu thị 
một đối tượng của thế giới thực thông qua dữ liệu chứa trong thanh ghi. Chẳng hạn, trong 
cơ sở dữ liệu Cruise, thông tin về mỗi chuyến khảo sát sẽ được chứa trong một thanh ghi. 
Để đảm bảo rằng tất cả các dữ liệu thu thập được trong cùng một chuyến khảo sát được 
liên hệ với nhau thông qua một thanh ghi duy nhất, ngưòi ta chọn trường CRUISE_1D 
làm trường khoá. Có thể thấy ngay ưu điểm của trường này so với một so trường khác, 
chẳng hạn như trường VESSEL NAME (tên tàu), vì nó đảm bảo tính duy nhất của mồi 
chuyến khảo sát, do trong thực tế một tàu có thể thực hiện cùng lúc nhiều chuyến khảo 
sát khác nhau.

2.2.2 Trương và các tính chất của trường

2.2.2.1 Tên trường

Access không quá nghiêm ngặt cho việc đặt tên trường và do đó người sử dụng có 
thể đặt các tên khá dài và rõ nghĩa cho các trường, vấn đề là ở chỗ bạn sẽ phải gõ các tên 
trường này khi xây dựng các tra vấn, các lệnh macros, và các đơn thể chương trình. Vì 
vậy, bạn nên cân nhắc để lựa chọn giữa việc đặt một tên trường rõ nghĩa với việc đặt một 
tên trường dễ nhập vào máy. Tốt nhất, bạn nên đặt các tên trường ngắn gọn nhưng đủ rõ 
nghĩa và không có các dấu cách.

Ngoài ra, bạn cũng cần hết sức tránh dùng các ký tự đặc biệt để đặt tên cho các 
trường hay các đối tượng cơ sở dữ liệu. Mặc dù Access cho phép bạn sử dụng các tên 
theo kiểu Customer# , các ký tự đặc biệt (như #, /, $, %, @, ...) có thể làm nảy sinh các
rắc rối cho bạn trong các giai đoạn tiếp theo.
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2.2.2.2 Các loại dữ liệu

Tính chất data type (loại dữ liệu) của một trường sẽ báo cho Access biết cách xừ 
lý các dữ liệu chứa trong trường đó. Chẳng hạn, nếu loại dữ liệu là date/ time, Access sẽ 
có thể xừ lý các phép toán số học với các dữ liệu kiểu ngày tháng/thời gian chứa trong 
trường. Nấu cũng loại dữ liệu đó nhưng được lưu dưới dạng text, Access sẽ xử lý các dữ 
liệu này như bất kỳ một chuỗi hay một ký tự dạng văn bản. Thông thường, bạn có thể lựa 
chọn loại dữ liệu theo ý mình. Tuy nhiên, bạn cần lưu ý một số vấn đề sau:

1. Không sử dụng dừ liệu loại numeric (số) trừ phi bạn chắc chắn rằng trường này sẽ lưu 
các dữ liệu dạng số (chẳng hạn bạn muốn áp dụng các phép tính toán đối với các dữ liệu 
này). Ví dụ như, một trạm đo có thể được mô tả như một dữ liệu dạng số trong nhiều 
trường hợp, nhưng bạn cũng có thể dùng các ký hiệu dạng chữ số (như 12A, 12B, v.v...) 
đê biêu thị các trạm đo.

2. Access chung cấp một loại dừ liệu đặc biệt gọi là Auto Number (Số tự động), về 
thực chất, autonumber là một dừ liệu loại Long Integer có chức năng tự động tăng lên 
mồi khi có một thanh ghi được thêm vào bảng. Như vậy, nó có thể được sử dụng rất 
thuận tiện như một trường khoá chính khi không tìm ra được trường khoá nào trong bảng.

Do số tự động là một số nguyên dạng Long Integer và do các quan hệ chỉ có thể 
được tạo ra giữa các trường có cùng loại dữ liệu, một điều rất quan trọng cần nhớ là nếu 
một số tự động được gán cho phía "một" của quan hệ thì phía "nhiều" cũng phải được gán 
loại Long Integer.

2.2.2.3 Các mặt nạ nhập liệu

Mặt nạ nhập liệu là một phương tiện để hạn chế những thông tin được người sử 
dụng nhập vào trường. Phương tiện này cung cấp một "khuôn mẫu" để thông báo cho 
Access biết để loại thông tin nào được lưu trữ trên mỗi vị trí. Chẳng hạn, mặt nạ nhập 
liệu >LLLL sẽ bao gồm hai phần:

1. Dấu lớn hơn > sẽ đảm bảo để bất kỳ một ký tự nào do người sử dụng gõ vào cũng sẽ 
được chuyển đổi thành dạng chừ in hoa. Chẳng hạn, nếu người sử dụng gõ vào từ comm, 
nó sẽ được tự động chuyển thành COMM.

2. Các ký tự LLLL biểu thị các vị trí bắt buộc phải nhập các chữ từ A đến z mà không 
được để trống. Điều này có nghĩa là người sử dụng bắt buộc phải gõ vào bốn chữ cái. 
Nếu người sử dụng gõ vào ít hơn bốn chữ cái hoặc một ký tự nào đó khác các chừ cái từ 
A đến z  (chẳng hạn &, 7, %), Access sẽ hiển thị một thông báo lỗi.

Có rất nhiều ký hiệu đặc biệt dùng để tạo các mặt nạ nhập liệu. Bạn không nhất 
thiết phải ghi nhớ những ký hiệu đặc biệt này. Thay vào đó, bạn chỉ cần đưa trỏ chuột vào 
vị trí của mặt nạ nhập liệu và nhấn phím F1 để xem trợ giúp. Ngoài ra, có thể sử dụng 
thuật đồ để tạo ra các mặt nạ nhập liệu cơ bản mà sau đó bạn có thể sừa đổi cho phù hợp.

2.2.2.4 Mặt nạ nhập liệu và các giá trị tự điền

Bạn có thể dùng mặt nạ nhập liệu để điền tự động một ký tự (như một dấu trống 
hoặc một gạch nối) vào trường cần nhập dừ liệu, bằng cách gõ một dấu xổ xuống để chỉ
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ra rằng ký tự tiếp theo là một ký tự sẽ được máy tính điền sẵn. Chẳng hạn, để tạo mặt nạ 
nhập liệu cho một số điện thoại (như 822- 6109), bạn có thể sử dụng mẫu sau: 000\- 
0000; 0 (ở đây dấu gạch nối là ký tự được tự điền và sẽ xuất hiện tự động khi người sử 
dụng gõ sổ điện thoại vào).

Dấu chấm phẩy và số 0 ở cuối mặt nạ nhập liệu đóng vai trò quan trọng, như được 
giải thích trong phần trợ giúp trực tuyến, bởi một giá trị mặt nạ nhập liệu thường bao gồm 
ba phần (hay còn gọi là ba "đối số"), cách nhau bởi dấu chấm phẩy như sau:

• Nội dung mẫu mặt nạ nhập liệu (trong trường hợp này là 000\- 0000 ),

• Một giá trị (0 hoặc 1) thông báo cho Access biết cách cư xử với các ký tự tự điền, 
và

• Ký tự được sử dụng để đánh dấu vị trí (thông báo cho người sử dụng biết cần phải 
gõ vào bao nhiêu ký tự).

Khi bạn sử dụng một giá trị tự điền trong mặt nạ nhập liệu, đối số thứ hai sẽ xác 
định giá trị tự điền đó có được lưu trong cơ sờ dừ liệu hay không.

Chẳng hạn, nếu bạn sử dụng mặt nạ nhập liệu 000\ - 0000; 1 , Access sẽ không 
luru dấu gạch nối đó trong cơ sờ dừ liệu. Cụ thể là, mặc dù mặt nạ nhập liệu vẫn luôn luôn 
hiển thị số điện thoại trên màn hình máy tính dưới dạng "822- 6109", trong thực tế nó chỉ 
được lưu trong cơ sở dừ liệu dưới dạng "8226109". Nếu bạn sử dụng mặt nạ nhập liệu 
dạng 000\- 0000; 0 , bạn sẽ thông báo cho Access biết cần phải lưu dấu gạch nối cùng với 
phần dữ liệu còn lại. Nếu bạn sử dụng thuật đồ để tạo mặt nạ nhập liệu, Access sẽ hỏi bạn 
một câu hỏi đơn giản về việc lưu trừ các giá trị tự điền (như minh họa trên Hình 2.6) và 
sẽ tự điền đối số thứ hai một cách tương ứng. Tuy nhiên, nếu bạn tạo mặt nạ nhập liệu 
không dùng thuật đồ, bạn cần biết rằng theo mặc định, Access không lưu các giá trị tự 
điền. Nói cách khác, mặt nạ nhập liệu ooovoooo tương đương vói mặt nạ nhập liệu 000\- 
0000; 1 . Điều này sẽ làm nảy sinh những vấn đề nghiêm trọng trong trường hợp trường 
đang xét được bị ràng buộc bởi tính toàn vẹn dữ liệu tham chiếu (giá trị "822- 6109" khác
với giá trị "8226109").

-  16-
Tài liệu giảng dạy -  Khoa Môi trường, Trường đại học khoa học tự nhiên



Nguyễn Hồng Phương -  Thực hành xây dựng cơ sở dử liệu quan hệ bằng
Access

Bài tập 3. Tạo các quan hệ

3.1 ưu  điểm của việc sử dụng các bảng và các quan hệ

Những người chưa có nhiều kinh nghiệm trong việc thiết kế cơ sở dữ liệu (haỵ 
những người quen làm việc với các dữ liệu dạng ghi chép) hay mắc phải một lôi khá phô 
biến, đó là thay vì việc cần phải thiết kể một mô hình phản ánh lĩnh vực nghiên cứu dưới 
dạng các thực thể và các mối quan hệ giữa chúng, họ thường có xu hướng gộp tất cả các 
thông tin cần thiết vào một bảng lớn.

Phương án gộp tất cả dữ liệu vào một bảng lớn có lợi thế là nó không đòi hỏi phải 
suy nghĩ gì nhiều trong giai đoạn đầu của quá trình thiết kế cơ sở dữ liệu. Tuy nhiên 
những bất lợi kèm theo phương án này lại rất nhiều, ở đây chỉ liệt kê một số bất lợi chính:

1. Tốn nhiều chỗ chứa dữ liệu

2. Khó thay đổi cấu trúc cơ sở dừ liệu

3. Các vấn đề nảy sinh khi xoá dừ liệu

4. Các vấn đề nảy sinh khi thêm dữ liệu

3.1.1 Thiết kế bảng "Chuẩn hoá"

Các vấn đề nêu trên có thể tránh được bằng cách chia nhỏ các bảng chứa dừ liệu. 
Chẳng hạn ta có thể đưa các dữ liệu khảo sát vào hai bảng sau:

1. Bảng Chuyển khảo sát — chỉ chứa các thông tin về chuyến khảo sát;

2. Bảng Trạm đo— chứa thông tin về mồi (điểm lấy mẫu).

Vấn đề mấu chốt ở đây là bạn phải xác lập một mối quan hệ giữa Chuyển khảo sát 
và Trạm đo sao cho khi nhìn vào bảng Trạm đo, ta có thê biêt được nó thuộc chuyên khảo 
sát nào (xem Hình 3.1).

Vì mỗi chuyến khảo sát có thể bao gồm từ một đến nhiều điểm đo, mối quan hệ 
này được gọi là quan hệ "Một-nhiều".

Access sử dụng các mối quan hệ theo cách sau đây:

Giả sử bạn muốn tìm tất cả các trạm đo được thực hiện trong chuyến khảo sát số 1. 
Do trường CRUISE_ID (Mã chuyến khảo sát) có mặt trong cả hai bảng Station và Cruise 
tạo ra mối quan hệ giữa hai bảng này, Access có thể lần theo mối quan hệ này từ bảng 
Cruise sang bảng Station đê tìm ra tất cả các thông tin về các điểm đo được thực hiện 
trong chuyến khảo sát này.
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: Relationships

p^.u jfiiuwHf 95®« T!W I A
CRUISE ID CRUISE ID
PROJECT NAME STATION NO
INSTITUTE DATE
VESSEL DEPTH
START_DATE LAT

1END_DATE LONG
! AREA WEATHER
CHIEF_SCIENTIST WIND DIR

¡REMARKS WIND_SPEED
TEMP DRY
TEMP WET
AIR PRESSURE
CLOUDY

Hình 3.1: Mối quan hệ một-nhiều giữa hai bảng Cruise và Station.

3.2 Bài tập

3.2.1 Tạu quan hệ giữa các bảng

• Mở cửa sổ database của cơ sỡ dữ liệu Cruise.

• Chọn Relationships từ lệnh đơn Tools

• Đe đưa một bảng vào cửa sổ Relationships, chọn Show Table từ lệnh đơn 
Relationships hoặc nhấn phím Show Table trên thanh công cụ.

• Thực hiện các bước như minh họa trên Hình 3.2 để đưa các bảng Cruise, Station 
và Observation vào cửa sô Relationships.

• Xác lập quan hệ giữa khoá chính trong bảng Cruise và khoá phụ trong bảng 
Station như minh họa trên Hình 3.3.
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CRUISEJD
PROJECT_NAME
INSTITUTE
VESSEL
START_DATE
END_DATE
AREA
CHIEF_SCIENTIST
REMARKS

Station

STATION J D /V

CRUISE JÕ
STATION.NO
DATE
DEPTH
LAT
LONG
WEATHER
WIND_DIR
WIND_SPEED
TEMP_DRY
TEMP.WET
AIR_PRESSURE
CLOUDY

> ; : ÎT 3

5TATI0NJD
TIME
DEPTH
TEMPERATURE
SALINITY
SIGMA_T
OXYGEN
PHOSPHATE
NITRATE
SILICATE

Show Tablo

Add

Close

Hình 3.2: Thêm các bảng Cruise, Station và Observation vào cửa sổ relationship.

CRUISE JD
PROJECT_NAME
INSTITUTE
VESSEL
START_DATE
END.DATE
AREA
CHIEF_SCIENTIST
REMARKS

IỄPẼI®

Station

S T A T IO N D A

CRUISEJD
STATIONJJO
DATE
DEPTH
LAT
LONG
WEATHER
WIND_DIR
WIND_SPEED
TEMP_DRY
TEMP_WET
AIR_PRESSJRE

1 CLOUDY Si

OBSERVATIONJ  *
STATION _ID
TIME
DEPTH
TEMPERATURE
SALINITY
SIGMA_T
OXYGEN
PHOSPHATE
NITRATE
SILICATE V

Edit Relationships

Table/Query: Related Tabie/Query:

Cruise •»I Station

CRUISE ID CRUISE ID A

—
V

W  Enforce Referential Integrity 

P  Cascade Update Related Fields 

P  Cascade Delete Related Records

Cancel

Join Type..

Create New..

Relationship Type: One-To-Many
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Hình 3.3: Tạo quan hệ giữa hai bảng.

Buớc 1. Chọn bảng bạn muốn thêm vào rối kích đúp trỏ chuột vào tên bảng hoặc nhấn 
phím Add. Nhắc lại thao tác này nếu cần thiết.

• Mỗi hình chừ nhật chứa danh sách các trường biểu thị một bảng. Chú ý rằng các 
khoá chính được biểu thị bằng các chữ in đậm.

• Nếu bạn thêm một bảng vào cửa sổ Relationships lần thứ hai, nó sẽ xuất hiện dưới 
tên gọi <Tên bảng>_l. Để xoá bảng, kích chuột vào một điểm bất kỳ trên bảng 
rồi nhấn phím delete.

Bước 2. Chọn khoá chính từ phía “một” của quan hệ.

Bước 3. Giữ chuột và kéo các trường đã được chọn sang phía "nhiều" của quan hệ và nhả 
chuột.

Bước 4. Kiểm tra để đảm bảo chắc chắn là các trường đã có quan hệ với nhau.

Bước 5. Đánh dấu vào hộp kiểm để ràng buộc tính toàn vẹn tham chiếu (Enforce 
referential integrity).

• Nếu bạn thực hiện chính xác các bước như mô tả, các ký hiệu quan hệ ( ì - co) sẽ 
xuất hiện trên đường kẻ biểu thị quan hệ.

3.2.2 Chỉnh sửa và xoá các quan hệ

Thông thường, bạn sẽ phải thực hiện thao tác chỉnh sửa hoặc xoá một mối quan 
hệ trong hai trường hợp sau đây:

1. Bạn muốn thay đổi loại dữ liệu của một trong số các trường đã được tạo quan 
hệ — Access sẽ không cho phép bạn thực hiện việc thay đổi này nếu bạn không 
xoá mối quan hệ đó đi (sau khi thay đổi loại dữ liệu, bạn sẽ phải tạo lại mối quan 
hệ đó).

2. Bạn quên không xác lập tính toàn vẹn tham chiếu — tức là khi các kỷ hiệu 
quan hệ "1" và "oo" không xuất hiện trên đường kẻ biểu thị quan hệ, đó là do bạn 
đã quên đánh dâu vào hộp kiểm “Enforce referential integrity”.

Trong mục này, giả sử bạn đã quên xác lập tính toàn vẹn tham chiếugiữa các bảng 
Cruise và Station. Bạn hãy chỉnh sửa mối quan hệ giữa hai bảng này. Chú ý rằng việc xoá
một bảng trong cửa sổ relationship về thực chất không phải là việc xoá mối quan hệ, mà 
chỉ là dấu nó khỏi màn hình.

• Chọn mối quan hệ bằng cách kích chuột lên đường kẻ quan hệ. Nếu bạn thực hiện 
đúng, đường kẻ sẽ trở nên đậm nét.

• Với mối quan hệ đã được chọn, kích chuột phải để mở lệnh đơn edit/delete. Nếu 
bạn không thấy lệnh đơn này xuất hiện, hãy chọn lại mối quan hệ.
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• Các ký hiệu "1" và " 8" biến mất chứng tỏ tính toàn vẹn tham chiếu đã mất hiệu
lực.

3.3 Thảo luận

3.3.1 Các moi quan hệ Một-một

Ba loại mối quan hệ được áp dụng trong việc thiết kế mô hình dữ liệu bao gồm:

1. Một-raột — mối quan hệ Một-một tồn tại giữa một chuyến khảo sát và một 
trạm đo khi chỉ có một trạm đo đơn lẻ (đo một lần).

2. Một-nhiều — mối quan hệ Một-nhiều tồn tại giữa chuyến khảo sát và trạm đo 
khi có nhiều hơn một trạm đo được thực hiện trong mỗi chuyến khảo sát, nhưng mỗi trạm 
đo chỉ thuộc một chuyến kháo sát duy nhất.

3. Nhiều-to-nhiều — mối quan hệ Nhiều-nhiều có thể tồn tại giữa chuyến khảo 
sát và trạm đo khi mỗi trạm đo thuộc nhiều hơn một chuyến khảo sát. Loại quan hệ này 
không thể áp dụng trong cơ sở dữ liệu của chúng ta.

Phương pháp mô hình hoá dữ liệu phổ biến nhất hiện nay là phương pháp sử dụng 
sơ đồ Thưc thể-Quan hệ. Mặc dù phương pháp này cho phép mô tả các mối quan hệ 
Nhiêu-nhiêu, các môi quan hệ này không được áp dụng trong việc thiêt kê các cơ sở dữ 
liệu quan hệ.

Thông thường, các mối quan hệ Nhiều-nhiều thường được phân nhỏ ra thành một 
loạt các mối quan hệ Một-nhiều thông qua các thực thể tổng h(/p (composite entities), hay 
còn gọi là các "bảng bắc cầu".

3.3.2 Tính toàn vẹn tham chiếu

Một trong những đặc tính quan trọng của Access là nó cho phép bạn ràng buộc 
tính toàn vẹn tham chiếu cho các mối quan hệ. Tính toàn vẹn tham chiếu là gì? v ề  bản 
chất, tính toàn vẹn tham chiếu đảm bảo để ứng với mỗi một thanh ghi bên phía "nhiều" 
của quan hệ sẽ tồn tại một thanh ghi lương ứng bên phía "một" của quan hệ.

Việc bạn ràng buộc tính toàn vẹn tham chiếu có nghĩa là bạn sẽ không thể nhập 
một thanh ghi mới vào bảng Station mà không có một thanh ghi hợp lệ tương ứng nằm 
bên bảng Cruise. Ngoài ra, tính toàn vẹn tham chiếu sẽ cản trở việc xoá các thanh ghi bên 
phía "một" nếu hiện đang tồn tại các thanh ghi tương ứng bên phía "nhiều" của mối quan 
hệ. Điều này sẽ loại bỏ vấn đề về các thanh ghi "cọc cạch" (còn gọi là các thanh ghi “mồ 
côi”) bị thừa ra khi các thanh ghi chính (còn gọi là các thanh ghi cha mẹ) bị xoá khỏi cơ 
sở dữ liệu.

Trong các hệ thống không được tự động ràng buộc tính toàn vẹn tham chiếu, việc 
kiểm tra sẽ phải được thực hiện bằng các chương trình được viết trên các ngôn ngừ lập 
trình. Đây cũng là một ví dụ cho thấy ưu điểm của Access đã giúp cho bạn tránh được 
một khối lượng lớn công việc lập trình.
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Bạn sẽ thấy hiệu lực của việc ràng buộc tính toàn vẹn tham chiếu được phản ánh 
ngay trong quy trình nhập dữ liệu: bạn không thể nhập liệu vào phía "nhiều" của bảng 
nếu chưa có dữ liệu được nhập vào phía "một".
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Bài tập 4. Công cụ Tra vấn
4.1 Sử dụng tra vấn để tìm các thông tin cần thiết

Các tra vấn cho phép người sử dụng kết hợp dữ liệu từ một hay nhiều bảng, khai
thác dữ liệu bằng nhiều cách khác nhau, tính toán và đưa kết quả vào một trường mới, và
xác lập tiêu chuẩn để lọc ra và kết xuất các thanh ghi dữ liệu cùa bảng.

Bạn cần biết rằng bản thân một tra vấn không chứa dữ liệu bên trong— nó chỉ 
thực hiện chức năng tổ chức lại dữ liệu từ một (hay nhiều) bảng nhưng lại không hề thay 
đổi nội dung của bảng hay các bảng đó.

Khi một tra vấn được xác định, nó có thể được sử dụng giống hệt như một bảng. 
Vì vậy, có thể hình dung tra vấn như một "bảng ảo". Tương tự, trong một số hệ quản trị 
cơ sở dữ liệu, các tra vấn cũng còn được gọi là các "cảnh (views)" bải lẽ chúng cho phép 
những người sử dụng khác nhau và các ứng dụng khác nhau có được những hình dung 
khác nhau về cùng một tập dữ liệu.

4.2 Bài tập

4.2.1 Tạo một tra vấn

• Sử dụng các bước minh họa trong Hình 4 .1 để tạo một tra vấn mới trong mục 
Queries của cửa sổ database.

• Thêm bảng Cruise vào tra vấn.

• Kiểm tra các thành phần chính của màn hình thiết kế tra vấn như minh họa
trên Hình 4.2.

• Lưu tra vấn (Control-S) dưới tên gọi qryCruise.

Bước 1. Chọn tab Queries trong cửa sổ database.

Bước 2. Chọn Create query in Design View (Tạo Tra vấn trong dạng xem thiết kế) đế tạo
tra vấn mới.

Bước 3. Thêm bảng Cruise vào tra vấn bằng cách chọn nó từ cửa sổ Show Table và nhấn 
Add (hoặc bạn chỉ cần kích đúp trỏ chuột vào tên bảng mà bạn muốn thêm vào).

Bước 4. Nhấn Close khi kết thúc (cửa sổ "showtable" sẽ không cho bạn thực hiện các 
thao tác tiếp theo nếu bạn chưa đóng nó lại).

• Phần phía trên của màn hình chứa danh sách các trường của bảng (hay các bảng)
được sử dụng để tạo tra vấn.

• Phần phía dưới của màn hình là vùng tạo tra vấn.

• Hàng Field (Trưởng) chứa tên của các trường được đưa vào tra vấn.
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Hàng Table (Bảng) chứa tên của bảng có trường hiện được đưa vào tra vấn.
Ịy  M icro so ft Accbss

£ile Edit ỵiew Insert Query Tools Window Help

«I* e s  te» s* ! H z

Ready

1 ỉ ;  start C:\Doajnents... Wndows r>te>á .. s'œ GuieRepoft : .. Queryl :Selec... 3  Batac*_ACCE... EEHI 7:12am

Hình 4.1: Tạo một tra vấn mới.

IS8 Q u e ry l : S e lo c t Q uery

¥ Ai

CRUI5EID
PROJECT_NA 
INSTITUTE 
VESSEL

Field:
Table:
Sort:

Show:
Criteria:

or:

fcRUISE
-----  A

Cruise

M □ □ □ □

<

V

>
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Hình 4.2: Các thành phần chính của màn hình thiết kế tra vấn.

• Hàng Sort (Sắp xếp) cho phép bạn xác lập thứ tự hiển thị các thanh ghi.

• Các hộp Show (Hiển thị) xác định trường nào trong số các trường đã đưa vào tra
vấn được hiển thị.

• Hàng Criteria (Tiêu chuẩn) cho phép bạn xác lập tiêu chuẩn đưa các thanh ghi 
vào (hoặc loại trừ các thanh ghi khỏi) tập họp kết quả tra vấn.

4.2.2 Năm thao tác cơ bản của Tra vấn

4.2.2.1 Chiếu
Chiểu một trường vào tra vấn có nghĩa là đưa trường đó vào phần cửa sổ tạo tra

vấn.

• Thực hiện các bước minh họa trên Hình 4.3 để chiếu các trường CRUISE_ID, 
PROJECT_NAME, INSTITUTE, và VESSEL vào vùng tạo tra vấn.

• Chọn Datasheet View từ lệnh đơn View để xem kết quả tra vấn.

• Chọn Design View từ lệnh đơn View để quay lại chế độ xem thiết kế.

sẵ1 Q u e ry l : S e lec t Q uery GD®®

CRUISEJD

PROJECT_NA
INSTITUTE
VESSEL

Field:
Table:
Sort:

Show:
Criteria:

or:

CRUISE ID PROJECT NAME INSTITUTE VESSEL
------- A

Cruise Cruise Cruise Cruise

0 0 0 0 □

<

V

>

Hình 4.3: Chiếu một tập con các trường vào vùng tạo tra vấn.

Bước 1. Chọn trường bạn muốn đưa vào tra vấn rồi kéo vào ô thích họp trong vùng tạo 
tra vấn. Kích đúp trỏ chuột vào trường cũng cho kết quả tương tự.
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• Để chiếu tất cả các trường của bảng Cruise, bạn chi cần kéo dấu sao (*) vào vùng 
tạo tra vấn.

• Để tiếp kiệm thời gian chiếu các trường, bạn có thể chọn nhiều trường cùng lúc 
bằng cách giữ phím Control rồi kéo cả nhóm các trường vào vùng tạo tra vấn.

4.2.2.2 Sắp xếp theo thứ tự
Khi bạn dùng một tra vấn để sắp xếp dữ liệu theo thứ tự, về thực chất bạn không 

thay đổi thứ tự vật lý của các thanh ghi trong bảng gốc (tức là bạn không áp dụng thao tác 
sắp xếp đối với bảng gốc). Do vậy, các tra vấn khác nhau áp dụng cho cùng một bảng gốc 
có thể cho các kết quả hiển thị dữ liệu theo các thứ tự khác nhau.

CRUISE ID Project Name Institute Vessel

► 1 RAN Mk12 XBT Program AODC HMAS Newcastle
1 RAN Mk12 XBT Program AODC HMAS Torrens
3 W ESTPAC Hydrographic Dept, MSA Takuyo
4 W ESTPAC, ODP Ocean Research Institute Tansei Maru

*

Hình 4.5: sắp xếp các kết quả theo thứ tự cho một hay nhiều trường.

Bước 1. Chọn "ascending (tăng dần)'' cho trường INSTITUTE field (xem Hình 4.3).

Bước 2. Hiển thị các kết quả và chú ý thứ tự của các thanh ghi.

4.2.2.3 Chọn lựa
Bạn có thể chọn các thanh ghi bằng cách đưa ra điều kiện mà các thanh ghi đó 

phải thoả mãn để được đưa vào tập kết quả. Trong phương pháp "tra vấn bằng ví dụ " 
(query- by- example), bạn sẽ nhập các ví dụ bạn muốn có trong tập kết quả vào hàng 
criteria (tiêu chuân).

• Thực hiện các bước như minh họa trên Hình 4.6 để chọn các chuyến khảo sát thoả 
mãn điều kiện VESSEL -Tansei Maru

Bước L Gõ cụm từ" Tansei Maru " vào hàng criteria của trường VESSEL. Bạn cũng có 
thể gõ "= Tansei Maru ", nhưng dấu bằng luôn luôn được gán ngầm định, trừ phi bạn sử 
dụng một toán tử quan hệ nào khác.
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Bước 2. Hiển thị các kết quả. Bạn thấy rằng chỉ có những thanh ghi thoả mãn tiêu chuẩn 
trên mới được hiển thị.

1?  q ry  C ru ise : Select Query 0 0 ®

* /V
CRUISEJD

PROJECT_NA 
INSTITUTE 
VESSEL V

Field:
Table:
Sort:

Show:
Criteria:

'
PROJECT NAME INSTITUTE VESSEL

Cruise Cruise Cruise Cruise
Ascendinq

k 0 0 0 □
"Tansei Maru"

or:
<

V

>

Hình 4.6: Chọn một tập con các thanh ghi từ bảng Cruỉse thoả mãn một tiêu chuẩn
cho trước.

4.2.2.4 Liên kết
Một tra vấn dạng liên kết cho phép bạn khai thác dữ liệu từ nhiều bảng, sử dụng 

các quan hệ đã xác lập trong cơ sở dừ liệu.

• Đóug tra vấn qryCruise .

• Mở cử sổ quan hệ (relationships window) và đảm bảo rằng bạn đã xác lập một
mối quan hệ giữa Cruise và Station. Neu mối quan hệ này chưa được xác lập, bạn
hãy tạo mới (đừng quên ràng buộc tính toàn vẹn tham chiếu).

• Tạo một tra vấn mới có tên là Cruise Station dựa trên các bảng Cruise và Station.

• Chiếu CRUISEJD từ bảng Cruise và CRUISEJD, STATION_NO và DEPTH từ 
bảng Station (xem Hình 4.7).

Bước 1. Đưa các bảng Cruise và Station vào cừa sổ tra vấn. Chú ý rằng mối quan hệ giữa 
các bảng được kế thừa từ cửa sổ relationship.

Bước 2. Chiểu các trường từ cả hai bảng vào vùng tạo tra vấn.
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É1 Queryl : Solect Query

* A
CRUISED
PROJECTJJA 
INSTITUTE 
VESSEL V

<

5TAT10NID
CRUISEJD
STATION_NO
DATE
DEPTH V

Field:
Table:
Sort:

Show:
Criteria!

or:

CRUISE ID CRUISE ID STATION NO [ ........
A

Cruise Station Station Station

0 0 0 0

<
Y

>

Hình 4.7: Tạo tra vấn liên kết các bảng Cruise và Station.

ế.2.2.5 Tiêu chuẩn chọn lựa phức họp
Bạn cũng có thể tạo ra các tra vấn bằng cách sử dụng tiêu chuẩn chọn lựa phức 

hợp. Chẳng hạn, bạn muốn tìm tất cả các trạm quan trắc thuộc chuyến khảo sát số 4 và 
được đo ở độ sâu trên 1000 mét. Bạn hãy sửa lại tra vấn trước đó và thực hiện các bược 
minh họa trên Hình 4.8.

sip Queryl : SolQct Query

* /\ 
/~DI fTCjr m

1
1 U v U D tJ L *

PROJECT_NA
INSTITUTE
VESSEL

STATION_NO
DATE
DEPTH V

Field:
Table:
Sort:

Show:
Criteria:

or:

CRUISE ID CRUISE ID STATION NO DEPTH
Cruise Station Station Station

0 0 0 0
4 >1000

<

V

Hình 4.8: Tạo một tra vấn phức họp nối kết các bảng Cruise và Station.
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Bước L Nhập tiêu chuẩn "4" trong trường CRUISE_ID.

Bước 2. Gõ tiêu chuẩn ">1000" vào trường DEPTH.

Một ví dụ khác là bạn muốn tìm ngày bắt đầu và ngày kết thúc của tất cả các 
chuyến khảo sát được thực hiện tại khu vực có tên gọi là "Tasman Sea". Bạn hãy sừa lại 
tra vấn trước đó và thực hiện các bước minh hoạ trên Hình 4.9.

¡ế  Q uery l : Sslect Query o ® ®

Field:
Table:
Sort:

Show:
Criteria:

CRUISE ID INSTITUTE VESSEL AREA START DATE ÏND DATE
Cruise Cruise Cruise Cruise Cruise Cruise

0 0 0 0 0 0
Like “Tasman Sea"

or:
<

V

>

Hình 4.9: Tạo một tra vấn phức họp sử dụng toán tử like

Bước L Gõ tiêu chuẩn Like "Tasman Sea" vào trường AREA. Chạy tra vấn. Kết quả cho 
thấy chỉ có một thanh ghi duy nhất có chứa cụm từ Tasman Sea trong trường area.

Bước 2. Đổi tiêu chuẩn thành "* Tasman Sea *". Chạy lại tra vấn. Lần này kết quả cho 
hai thanh ghi có chứa cụm từ Tasman Sea. Chú ý rằng các từ khác biểu thị tên vùng đã 
xuất hiện đằng trước và đằng sau cụm từ Tasman Sea.

Ký hiệu * được sử dụng để mở rộng phạm vi tìm kiểm của tra vấn.

4.2.3 Tạo các trường tính toán

Trường tính toán là một trường "ảo" trong một tra vấn, với các giá trị là hàm của 
một hay nhiều trường khác lấy từ bảng gốc. Để minh hoạ, ta sẽ tạo một trường tính toán 
để tìm tổng số các trạm đo được thực hiện trên chuyến khảo sát số 1.

Tên của trường tính toán có thể lấy bất kỳ, miễn là nó không trùng với tên các 
trường khác trong bảng. Tiêu chuẩn có thể là một biểu thức bất kỳ mà Access có thể hiểu 
được.

• Tạo một tra vấn mới có tên là Total Station dựa trên các bảng Cruise và Station.

• Thực hiện các bước chỉ dẫn trong Hình 4.10 để tạo trường tính toán cho bảng 
Cruise.
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• Chạy tra vấn để kiểm tra các kết quả như minh họa trên Hình 4.11.

Field:
Table:
Total:
Sort:

Show:
Criteria:

or:

CRUISE ID STATION NO
----

Cruise Station
Group By k lo u n tH H H H P

[Max A
0 □ □

1 StDev
Var
First< >
Last
Expression
Where

Hình 4.10: Tạo một trường tính toán để đếm số thanh ghi

Bưởc 1. Đưa các bàng Cruise và Station vào tra vấn.

Bước 2. Chiếu các trường CRƯISE_ID và STATION_NO từ hai bảng vào vùng tạo tra 
vấn.

Bước 3. Gõ tiêu chuẩn "1" vào trườns CRUISE_ID.

Bước 4. Nhấn phím X trên thanh công cụ để tạo hàng Total trong vùng tạo tra vấn.

Bước 5. Chọn Count từ danh sách xổ các toán tử trong hàng Total của trường 
STATION_NO.

Kết quả của tra vấn này phải có dạng như sau:
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Hình 4.11: Kết quả đếm số các thanh ghi
Trường CountOfStation_NO là một trường ảo và không xuất hiện trong cơ sờ dữ

liệu.

4.3 Thảo luận

4.3.1 Quy ước đặt tên cho các đối tượng của cơ sở dữ  liệu

Access không quá nghiêm ngặt trong việc quy ước đặt tên cho các đối tượng trong 
cơ sờ dữ liệu. Tuy nhiên, việc chọn các tên gọi rõ nghĩa, phù hợp sẽ tiết kiệm đáng kể 
thời gian và tránh được những nhầm lẫn về sau cho những người xây dựng cơ sở dữ liệu. 
Mặc dù không có những quy ước cụ thể cho việc đặt tên, bạn cần lưu ý đến một số điểm 
sau đây:

• Sử dụng những tên gọi có nghĩa — chẳng hạn một tên bảng là Table 1 không phản 
ánh nội dung dữ liệu chứa trong bảng. Hon nữa, vì không quá bị hạn chế về độ dài 
tên, bạn không nên dùng những tên gọi quá ngắn, tên gọi viết tắt theo kiểu s96w_ 
b. Khi số đối tượng trong cơ sờ dữ liệu của bạn tăng lên theo thời gian, bạn lại 
càng cần phải cẩn thận trong việc đặt tên co các đối tượng của cơ sở dữ liệu.

• Sừ dụng chữ hoa thay vì sử dụng các dấu cách — không như nhiều hệ quản trị cơ 
sở dữ liệu khác, Access cho phép sử dụng các dấu cách trong tên gọi các đối 
tượng. Tuy nhiên, nếu bạn chọn việc sử dụng các dấu cách, bạn sẽ phải gõ thêm 
dấu ngoặc kép cùng với các tên trường khi bạn đưa chúng vào các biểu thức 
(chẳng hạn [Project Name]). Vì vậy, bạn nên sử dụng tên ProjectName thay vì tên 
Project Name.

• Hãy thêm vào tên của mỗi loại đối tượng một tiếp đầu ngữ (hoặc tiếp vĩ ngữ) để 
phân biệt — Điều này đặc biệt quan trọng trong việc sử dụng các tra vấn bời lẽ 
các bảng và các tra vấn không thể có cùng tên. Chẳng hạn, bạn không thể có một 
tra vấn tên là Cruise trong khi đã có một bảng tên là Cruise. Trong khi đó, nếu 
bạn đặt tên cho tất cả các tra vấn của mình dưới dạng qryCruise, bạn có thể dễ 
dàng phân biệt giữa các bảng với các tra vấn.

• Hãy thiên về việc sử dụng các ký tự dạng chữ số thông dụng — bạn nên giới hạn 
dùng các ký tự như [A... Z], [a... z], [0... 9], có thể dùng thêm gạch dưới (_) và 
gạch nối (-). Mặc dù Access cho phép sử dụng gần như bất kỳ ký tự nào, các vấn 
đề có thể sẽ nảy sinh nếu bạn dùng những ký tự đặc biệt như ký tự dấu thăng (#).
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4.3.2 Ký hiệu toán tử  Và (&)

Ký hiệu toán tử Và được hiểu như những ký hiệu toán từ khác (như +, *, -r) trừ
phi nó được sử dụng trong một xâu ký tự. Trong trường hợp này việc sử dụng dấu & sẽ 
có nghĩa là thêm một xâu ký tự vào cuối một xâu ký tự khác (do vậy dấu & còn có tên gọi 
khác là ký hiệu toán tử "ghép nối"). Chẳng hạn, biểu thức "Fừst string" & "Second 
string" sẽ cho kết quả là: First strìngSecond string.

Tuy vậy, nếu ta điền thêm một dấu cách vào giữa dấu ngoặc kép và ký tự đầu của 
xâu thứ hai (" Second string"), thì kết quả sẽ là: First string Second string.
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Bài tập 5. Tra vấn bằng ngôn ngữ cấu trúc (SQL)

5.1 Sự khác biệt giữa QBE và SQL

Ngôn ngữ tra vấn bằng ví dụ (QBE) và ngôn ngữ tra vấn có cấu trúc (SQL) là hai 
ngôn ngữ chuẩn dùng để kết xuất thòng tin từ các hệ quản trị cơ sở dữ liệu quan hệ. ưu  
điểm cùa QBE là nó có chứa đồ hoạ và tương đối dễ sử dụng. Ưu điểm của SQL là tính 
thông dụng của nó đã đạt tới phạm vi toàn cầu trong thế giới cơ sở dữ liệu quan hệ. Trừ 
một số rất ít các trường hợp ngoại lệ, hai ngôn ngữ QBE and SQL gần như hoàn toàn có 
thể hoán đôi vị trí cho nhau. Chỉ cần hiểu được các khái niệm cơ sờ (như các phép chiếu, 
chọn lựa, sắp xếp theo thứ tự, liên kết và các trường tính toán) của một ngôn ngữ, chắc 
chắn bạn sẽ hiểu được các khái niệm cơ sở của cả ngôn ngữ kia. Trong môi trường của 
Access, bạn có thể chuyển đổi giữa các phiên bản QBE và SQL của các tra vấn của mình 
chỉ bằng một nhan chuột.

5.2 Bài tập

Trong mục này, bạn sẽ tạo một vài tra vấn đơn giản bằng SQL.

• Tạo một tra vấn mới bằng cách kích đúp trỏ chuột vào “Create queries in Design 
View” trong mục Queries, nhưng đóng cửa sổ "show table" mà không thêm bảng.

• Chọn View > SQL View để chuyển sang ngôn ngữ SQL

5.2.1 Các tra vẩn SQL cơ sở

Một lệnh SQL điển hình có dạng như sau:

SELECT Cruise.CRUISEJD, Cruise.PROJECT_NAME, Cruise.INSTITUTE,
Cruise.VESSEL, Cruise.START_DATE, Cruise.END_DATE, Cruise.AREA FROM 
Cruise WHERE (((Cruise.AREA) = "Tasman Sea"));

Lệnh này bao gồm bốn phần:

1. SELECT <field 1, field 2, field n > ...— xác định các trường cần chiếu;

2. FROM <table> ... — xác định bảng (hoặc các bảng) gốc dùng để tạo tra vấn;

3. WHERE <condition 1 AND/ OR condition 2, AND/ OR condition n > — xác định 
một hay nhiều điều kiện mà mỗi thanh ghi cần phải thoả mãn để được đưa vào tập kết 
quả;

4. ; (dấu chấm phẩy) — tất cả các lệnh SQL phải được kết thúc bằng một dấu chấm phẩy 
(nhưng nếu bạn quên điều này, Access sẽ điền dấu chấm phẩy vào cho bạn).

Bây giờ, bạn sẽ vận dụng những hiểu biết trên để xây dựng một tra vấn bằng ngôn 
ngữ SQĩ

• Gõ dòng sau vào cửa sổ SQL: SELECT CRUISE_ID, PROJECT_NAME, 
INSTITUTE, VESSEL FROM CRUISE WHERE VESSEL="Tansei Maru"; (như 
minh họa trên Hình 5.1).

• Chọn View > Datasheet View để hiển thị kết quả.

-31 -
Tài liệu giảng dạy -  Khoa Mói trường, Trường đại học khoa học tự nhiên



Nguyễn Hồng Phương -  Thực hành xây dựng cơ sở dữ liệu quan hệ bằng
Access

• Chọn View > Query Design để hiển thị tra vấn dưới dạng QBE, như minh họa 
trên Hình 5.2.

• Lưu tra vấn dưới tên gọi VesselSQL Query.

si8 Queryl : Select Query
SELECT Cruise.CRUISEJD, Cruise.PROJECT_NAMEj Cruise.INSTITUTE, Cruise.VESSEL A
FROM Cruise
WHERE (((Cruise.VESSEL)="Tansei Maru"));

V

Hình 5.1: Mở một tra vấn dạng SQL

BÜ8 Quaryl : Select Query 0(&)(Si

aẵl

* A

CRUISEJD
PROJECT_NA
INSTITUTE
VESSEL

âsl

j ____ t a l

Field:
Table:
Sort:

Show:
Criteria:

CRUISE ID PROJECT NAME INSTITUTE VESSEL
Cruise Cruise Cruise Cruise

0 0 0 0
"Tansei Maru'i

<

V

>

Hình 5.2: Cùng một tra vấn ở dạng QBE

-32-
Tài liệu giảng dạy -  Khoa Môi trường, Trường đại học khoa học tự nhiên



Nguyễn Hồng Phương -  Thực hành xây dựng cơ sở dữ liệu quan hệ bằng
Access

5.2.2 Các mệnh đề phức hợp dạng WHERE

Bạn có thể sử dụng trực tiếp các điều kiện AND, OR, và NOT trong các mệnh đề 
phức hợp dạng WHERE.

• Tạo một tra vấn để tìm tất cả các chuyến khảo sát do tàu Tansei Maru thực hiện, 
và do Ông K Suyehứo làm khoa học trưởng:

SELECT CRUISEJD, PROJECT_NAME, INSTITUTE, VESSEL, CHIEF_SCffiNTIST 
FROM Cruise WHERE ((VESSEL=" Tansei Maru ") AND (CHIEF_SCIENTIST=" Mr 
K Suyehừo"));

Chú ý rằng trường văn bản phải chứa một xâu ký tự, chẳng hạn “Tansei Maru 
Tuy nhiên các trường số không chứa các dấu ngoặc kép.

5.2.3 Các tra vấn liên kết

Các tra vấn liên kết sử dụng cùng một loại chất liệu giống như của các tra vấn 
chọn lựa cơ bản. Chi có một điểm khác biệt duy nhất là lệnh FROM được thay bởi một 
lệnh mô tả các bảng được liên kết và mối quan hệ giữa các bảng này:

... FROM table 1 INNER JOIN table 2 ON table 1 .field 1 = table 2 .field 2 ...

• Tạo một tra vấn để tìm tất cả các trạm đo được thực hiện trong chuyến khảo sát 
số 4 và có độ sâu quan trắc lớn hơn 1000 mét:

SELECT Cruise.CRUISE_ID, Station.STATION_NO, Station.DEPTH FROM Cruise 
INNER JOIN Station ON Cruise.CRUISEJD = Station.CRUISE_ID WHERE 
(((Cruise.CRUISE_ID)=4) AND ((Station.DEPTH)>1000));

5.3 Thảo luận

Mặc dù văn phạm của ngôn ngữ SQL không quá khó, việc viết các tra vấn dài 
bằng ngôn ngừ này SQL dễ gây buồn tẻ và mắc lỗi. Vì vậy, bạn nên sử dụng ngôn ngữ 
QBE khi làm việc với Access.
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Bài tập 6. Làm việc vói các biểu mẫu

6.1 Sử dụng các biểu mẫu như thành phần cơ bản của một ứng dụng

Các biểu mẫu cung cấp giao diện giúp cho người sử dụng thực hiện các thao tác
với dữ liệu trong một ứng dụng kiểu cơ sở dữ liệu. Đổi với người thiết kế cơ sở dữ liệu,
biểu mẫu cho phép xác định chi tiết ngoại hình và hành vi của dữ liệu trên màn hình và 
kiểm soát tối đa các dữ liệu này ngay cả khi người sử dụng thực hiện các thao tác chỉnh 
sửa hay cập nhật dữ liệu.

Cũng như các tra vấn, các biểu mẫu không chứa dữ liệu bên trong. Thay vào đó, 
chúng lcung cấp các cửa sổ để hiển thị bảng và tra vấn. Trong mục này, bạn sẽ học cách 
tạo biểu mẫu bằng cách sử dụng các công cụ thiết kế của Access.

6.2 Bài tập

6.2.1 Tạo một biểu mẫu không dùng thuật đồ

Mặc dù Access cung cấp một thuật đồ để tạo một biểu mẫu đơn giản, bạn nên bắt 
đầu bằng việc tự tạo ra một biểu mẫu mà không dùng thuật đồ. Điều này sẽ khiến bạn 
hiểu rõ hơn những gì thuật đồ thực hiện và cho bạn những ý tường lựa chọn đầu ra khi sử 
dụng thuật đồ.

• Tạo một biểu mẫu trắng sử dụng bảng Cruise, như minh họa trên Hình 6.1.

• Các thành phần chính của cửa sổ thiết kế minh hoạ trên Hình 6.2. Sử dụng lệnh
đơn View để hiển thị phím toolbox (hộp công cụ) và cửa sổ field list (danh sách
trường) nếu chúng chưa được hiển thị.

Bước 1. Chọn tab Forms từ cửa sổ database.

Bước 2. Chọn Create form in Design View (không sử dụng thuật đồ)

Bước 3. Chọn bảng Cruise trong danh sách xổ phía dưới để gắn bảng này với biểu mẫu 
sắp tạo.

Vì biểu mẫu có thể được tạo trên cơ sở các bảng và các tra vấn nên bạn thấy một 
danh sách chứa tên tất cả các bảng và tra vấn hiện có trong cơ sở dữ liệu. (Ở đây rõ ràng 
là việc đặt những tên gọi có ý nghĩa cho các đối tượng đóng vai trò quan trọng).
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t o ISO Ra port : Databas» (Access 2000 fil» format)

I  Open HỄ Design [ i f  New
0- 0-
D -fc-
6- 6-

Objects

m  Tables 

ỂP Queries

E l Forms

B  Reports 

Pages 

2  Macros 

«ỊỊjt Modules

Groups

Qü Favorites

Name I Description Modified A
Iff] Create form in...

®  Create form b...

I New Form s ®

Design View
Form Wizard 
AutoForm: Columnar 
AutoForm: Tabular 
AutoForm: Datasheet 
AutoForm: PivotTable 
AutoForm: Pivotchart 
Chart Wizard 
PivotTable Wizard

Choose the table or query where 
the object's data comes from:

Cruise Station
Observation
qry_Area
qry_Cruise
qry_TotalStation
Station

I

Hình 6.1: Tạo một biểu mẫu mới để hiển thị dữ liệu từ bảng Cruise.

I I  Form1 : Form
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Hình 6.2: Các thành phần chính của cửa sể thiết kế biểu mẫu.

• Để thay đổi kích thước của biểu mẫu, dùng trỏ chuột kéo các cạnh của mục detail.

• Cửa sổ field  list hiển thị các trường trong bảng hay tra vấn sử dụng để tạo biểu 
mẫu.

• Các biểu tượng trong toolbox được dùng để tạo ra các mục đồ họa và các điều 
khiển trên biểu mẫu.

• Nếu danh sách trường (Field List) và phím hộp công cụ (Toolbox) không được 
hiển thị, bạn hãy sử dụng lệnh đơn View hoặc biểu tượng Toolbars để bật chúng 
lên.

6.2.1.1 Thêm các hộp văn bản có kết gán vào biểu mẫu

• Thêm một hộp thoại"kết gán" cho trường CRUISE_ID bằng cách dùng trỏ chuột 
kéo CRUISE_ID từ cửa sổ danh sách trường vào nền biểu mẫu như minh họa trên 
Hình 6.3.

• Định lại vị trí cho hộp văn bản CRUISE_ID nằm lên phía trên bên trái biểu mẫu.

Cần nhớ rằng bạn luôn luôn có thể sử dụng chức năng "undo" để sửa chữa các lỗi 
lầm. Bạn hãy chọn Edit > Undo từ lệnh đơn hay chỉ cần gõ Control-Z (tổ hợp phím này 
áp dụng được cho tất cả các ứng dụng của Windows)

Bi Form1 : Form

♦  Detail

PM SEJP: RUISE _JP

PRCOECT_NAME
INSTITUTE
VESSEL
START_DATE
tND_DAlt
AREA
CHIEF_SCIENTIS1
REMARKS -
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Hình 6.3: Tạo một hộp văn bản kết gán cho trường CRUISE_ID.

• Kéo các trường còn lại vào biểu mẫu như minh họa trên Hình 6.4 (bạn chưa cần 
quan tâm đến việc định vị các trường này trong biểu mẫu).

• Chọn View > Form để xem biểu mẫu vừa tạo.

• Chọn View > Form Design để quay lại dạng xem thiết kế.

Bước 1. Chọn trường CRUISE_ID từ danh sách trường.

Bước 2. Kéo trường đã được chọn (tô đậm) vào mục detail của biểu mẫu.

Access sử dụng tính chất chú thích trường (caption) là giá trị mặc định để gán 
nhãn cho hộp văn bản. Nếu bạn không gõ gì vào mục caption, thì tên trường sẽ được sử 
dụng cho việc này (chẳng hạn, CRU1SE_ID). Đe tiết kiệm thời gian giành cho việc chỉnh 
sửa nhãn, bạn hãy chọn các chú thích thích hợp để gõ vào mục caption.

Để di chuyển một đối tượng cùng với nhãn của nó, bạn đưa hãy trỏ chuột vào 
giữa đối tượng, sau đó giữ và kéo đối tượng đó (con trỏ sẽ có hình bàn tay đang xoè cả 
năm ngón). Đê di chuyên một đôi tượng hay một nhãn đơn lẻ, bạn đưa hãy trỏ chuột vào 
góc trên bên trái, sau đó giữ và kéo (con trỏ sẽ có hình bàn tay đang chỉ bằng ngón trỏ).

Bước 1. Thêm các trường còn lại vào biểu mẫu.

Bước 2. Chọn Form View từ lệnh đơn View để hiển thị biểu mẫu.

ã i Cruls«3 0 ® B

► Cruise No El

Project Name RAN Mk12XBT Program

Institute AODC

Vessel HMAS Torrens

Star Date 1/29/1998

End Date 2/19/1998

Area

Chief Scientist

Tasman Sea

Remarks I These are routine Mk12 deployments

Record: H  | 1 ►J M |M r |  of 4
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Hình 6.4: Chọn Form View để hiển thị kết quả

Bạn có thể thêm nhiều trường vào biểu mầu một lúc chỉ bằng một thao tác kéo trỏ 
chuột bằng cách nhấn và giữ phím Control trong khi chọn các trường từ danh sách 
trường.

6.2.1.2 Sử dụng các tính chất của trường để bảo vệ nộỉ dung của trường

Mỗi đối tượng trên một biểu mẫu của Access form (chẳng hạn như hộp văn bản, 
nhãn, phần chi tiết của biểu mầu, v.v...) đều có một loạt các tính chất có thể thay đổi 
được. Tron" mục này, bạn sẽ sử dụng các tính chất Locked (Khoá) và Enabled (Được 
phép) đê kiêm soát các hành vi mà người sử dụng có thê tác động lên dữ liệu trong một 
trường.

• Chọn hộp văn bản CRUISE_ID và kích chuột phải để hiển thị cửa sổ property 
(tính chất) như minh họa trên Hình 6.5.

• Cuộn xuống phía dưới và tìm đến tính chất Locked, rồi chọn Yes, như minh họa 
trên Hình 6.5.

• Chuyển sang chế độ hiển thị biểu mẫu và thử thay đổi nội dung dừ liệu chứa trong 
trường CRUISE_ID.

l^fjQ pen Design ¿ I New X

n ru lss3 : Form

2000 fila  form at)

Objects

m Tables

Queries

m Forms

H Reports

m Pages

a Macros

Modules

Groups

& Favorites

. . . . . . .  1 . . . . . . .  2 ,

♦  Form Header
♦  Detail

Xante  No ! F ® : : : :

Project Name i|PR0JECT_NAME

Institute ] ¡INSTITUTE

Vessel............. ] ¡VESSEL

Star Date |START_D.

End Date : :j|END_DAT

A r e a ............. ]|AREA

Chief Scientist |CHIEF_SCIENTIST •

Bemaiks. . . . ÌỊREMARKS

\Ể  Text Box: CRUISE ID

| CRUISE_ID •» |

Format j Data | Event | Other All
Decimal Places....................  Auto
Input Mask...........................
Default Value......................
IME Hold.............................  No
IME Mode........................... No Control
IME Sentence Mode............. Phrase Predict
Validation Rule....................
Validation Text....................
Status Bar Text.................. Unique id
Enter Key Behavior.............  Default
Allow AutoCorrect................Yes
Visible.................................  Yes
Display When......................  Always
Vertical...............................  No
Enabled............................... Yes
Locked...............................  @
Filter Lookup......................  Database Default

Hình 6.5: Hiển thị cửa sổ property của hộp văn bản CRUISE_ID.
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Bước 1 ■ Chọn đối tượng mà bạn muốn xem tính chất (chẳng hạn hộp văn bản 
CRUISE_ID). Khi một đối tượng được chọn, nó sẽ được bao quanh bởi các hình chữ nhật 
nhỏ in đậm.

Bước 2. Kích phải chuột một lần lên đổi tượng đang được chọn để hiển thị lệnh đơn bật 
lên (pop-up menu).

Bước 3. Chọn Properties để hiển thị cửa so property (tính chất).

Các tính chất được chia thành bốn nhóm. Đe xem tất cả các tính chất, bạn chọn
tab All.

Hình thức bảo vệ dữ liệu mạnh hơn khoá là "vô hiệu hoá " (disable).

• Quay lại dạng xem thiết kế và thực hiện các thay đổi sau: xác lập tính chất Locked 
thành No\ xác lập tính chất Enabled thành No.

• Thử chỉnh sửa dữ liệu trong trường CRUISE_ID trong dạng xem biểu mẫu.

• Cất giữ biểu mẫu dưới tên gọi frmCruise

6.2.1.3 Thêm vào biểu mẫu một hộp văn bản không kết gán

Tất cả các hộp văn bản được tạo trong mục trước đều là các hộp văn bản "kết
gán"— tức là chúng được nối với một trường nào đó của bảng gốc hay tra vấn gốc được 
sử dụng để tạo biểu mầu. Khi bạn thay đổi giá trị dữ liệu chứa trong một hộp văn bản kết 
gán, bạn sẽ trực tiếp làm thay đổi các dừ liệu chứa trong bảng gốc.

Tuy nhiên, bạn cũng có thể tạo ra các đối tượng không bị ràng buộc bởi bất kỳ 
một bảng gốc hay tra vấn gốc nào trên một biểu mẫu.

Mặc dù bạn sẽ không sử dụng nhiều hộp văn bản "không kết gán" trong các ứng 
dụng của mình, bạn cũng nên biết các đối tượng loại này hoạt động ra sao.

• Tạo một biểu mẫu trống kết gán với bảng Cruise và lun nó dưới tên gọi 
frmCruiseUB .

• Chọn công cụ hộp văn bản và tạo một hộp văn bản không kết gán như minh họa 
trên Hình 6.6.
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Bi Forml : Form

♦  Detail

* é x tQ i ^Unbound

*
M  a b lQ  

i d  F

m m - i

Hình 6.6: Tạo một hộp văn bản không kết gán.

Bước 1. Chọn công cụ hộp văn bản từ hộp công cụ toolbox. Con trỏ lúc này sẽ biến thành 
một hộp văn bản nhỏ.

Bước 2. Kích trỏ chuột vào một điểm bất kỳ trên mục detail của biểu mẫu để tạo một hộp 
văn bản không kết gán mới.

6.2.1.4 Ràng buộc một hộp văn bản không kết gán với một trường

Sự khác biệt duy nhất giữa một hộp văn bản kết gán với một hộp văn bản không 
kết gán là ở chồ tính chat Control Source (Nguồn điều khiển) của một hộp văn bản kết 
gán được tự động gán cho tên của một trường. Trong mục này, bạn sẽ đổi hộp văn bản 
không kết gán thành một hộp văn bản kết gán như minh họa trên Hình 6.6.

• Hiển thị cửa sổ property cho hộp văn bản không kết gán. Thay đổi tính chất 
Control Source của nó bằng cách gõ CRUISE_ID vào chỗ trống như minh họa 
trên hình 6.7.
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[1

■# Detail

TextPijifcruiseJD

Toolb ▼ X

k ■ ;\

fîëxtÔ T |

Format | Data \ Event j Other AH
Name.................................... TextO
Control Source...................... Cruise_ID|
Format.................................
Decimal Places...................... Auto
Input Mask.............................
Default Value........................
IME Hold...............................  No
IME Mode............................. No Control
IME Sentence Mode.............. None
Validation Rule.....................
Validation T e x t......................
Status Bar T e x t...................
Enter Key Behavior..............  Default
Allow AutoCorrect.................Yes
Visible.................................... Yes
Display W hen........................  Always
Vertical.................................  No

Hình 6.7: Xác lập tính chất Control Source cho một hộp văn bản không kết gán.

Bước 1 ■ Sử dụng danh sách xổ để xác lập tính chất Control Source cho trường 
CRUTSFJD.

6.2.2 Sử dụng thuật đồ để tạo biểu mẫu một cột

Bây giờ khi đã nắm được các kiến thức cơ sờ về tạo và chỉn sửa các hộp văn bản 
kết gán, bạn có thể sử dụng thuật đồ tạo biểu mẫu để tạo các biểu mẫu của mình.

• Tạo một biểu mẫu mới kết gán với bảng Cruise sử dụng thuật đồ tạo biểu mẫu.

• Sử dụng thuật đồ tạo biểu mẫu để xác định các trường bạn muốn đưa vào biểu 
mẫu và quy định vị trí của chúng trên biểu mẫu như minh họa trên hình 6.9. Chọn 
biểu mẫu dạng "columnar (cột)" khi được hỏi.

Bước 1. Chọn thuật đồ tạo biểu mẫu.

Bước 2. Kết gán biểu mẫu với bảng Cruise.
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F o rm  W iza rd

PRCOECT_NAME
INSTITUTE
VESSEL
START_DATE
END_DATE
AREA
CHIEF_SCIENTIST

_ _ _
[==1 = = 1

= S ĩ  ị  ^
1

Tables/Queries

ịĩable: Cruise 

Available Fields:

A

[CRUISE ID .. n

Which fields do you want on your form?

You can choose from more than one table or query.

Selected Fields:

Cancel Next > Finish

Hình 6.8. Sử dụng thuật đồ tạo biểu mẫu để xác định các trường đưa vào biểu mẫu .

• Để đưa một trường vào biểu mẫu, kích đúp chuột vào trường đó hoặc nhấn phím 
có biểu tượng >.

• Để đưa tất cả các trường vào biểu mẫu, nhấn phím có biểu tượng » .

• Thứ tự xuất hiện của các trường trong cửa sổ nhỏ bên phải sẽ chính là thứ tự xuất 
hiện của các trường trong biểu mẫu. Sử dụng các phím < và «  để di chuyển các 
trường trở lại cửa sổ nhỏ bên trái.

Ưu thế lớn nhất cùa thuật đồ là nó cho phép tự động tạo, định dạng, và căn thẳng 
hàng các hộp văn bản kết gán. Tất nhiên, bạn có thể chỉnh sửa thoải mái các biểu mẫu 
được tạo bằng thuật đồ cho đến khi chúng hợp với ý của bạn.

6.3 Thảo luận

6.3. So sánh các biểu mẫu dạng cột, bảng và trang dữ liệu

Các biểu mẫu dạng Cột (Columnar) chỉ hiển thị một thanh ghi trên mồi trang. 
Ngược lại, các biểu mẫu dạng Bảng (Tabular) hiển thị nhiều thanh ghi trên mồi trangvà 
chủ yếu được sử dụng dưới dạng các biểu mẫu phụ (subíorms). Ngoài ra còn có các biểu 
mẫu dạng Trang dữ liệu (datasheet), nhirng các hiểu mẫu dạng này ít đtrợc dùng do 
chúng hạn chế khả năng của những người thiết kế cơ sở dữ liệu trong việc kiểm soát hình 
thức và ứng xử của các dừ liệu. Ba dạng khác nhau của biểu mẫu được minh họa trên 
hình 6.9.
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Bi C ru lso 3 BE®
► Cruise No r  d

Project Name |RAN Mk12 XBT Program

Institute |aodc

Vessel HMAS Torrens

Star Date |1/29/1998

End Date |2/19/1998

Area I Tasman Sea

Chief Scientist I
Remarks iThese are routine Mk12 deployments

Record: M | | \ 1 ► J M |M *J of 4

m Cruise!

e N o  Project Name Institute Vessel Date Date Area Chief Scientist Remarks

► 0 |RANMk12XBTPr |A0DC |HMAS [1998 |1998 |Tasman Sea I |These ate routine Mk12 deplc

2 |RANMk12XBTPr |AODC |HMAS |1996 |1996 1 Great Australia 1 |These are routine Mk12 deplc

3 JwESTPAC |Hydrographic Dept. [Tâkuyc |ĩ997 ỊĨ997 [East China Se. [Mr K Oka

I 4 |WESTPAC, ODP |0cean Research Ir |Tansei [1996 |1996 [Philippine Sea |MrKSuyehiro

*
I I  I I I I I I I

Record: H I 11 r ► I H !► * ! o f 4

S8 C ru lss4

CRUISE ID I PROJECT_NAME INSTITUTE VESSEL 1 START_|| END_D/'|
► j) RAN Mk12 XBT Program AODC HMAS Torret /29/1998 /19/1998

2 RAN Mk12 XBT Program AODC HMAS Newc /16/1996 /15/1996
3 WESTPAC Hydrographic Dept, MSA Takuyo /10/1997 6/8/1997
4 VVESTPA' , ODP Ocean Research Institute Tansei Maru /30/1996 /17/1996

*

I Record: H I 1 ► 1 M !► *! of 4 iL J j

Hình 6.9: Cùng một tập dữ liệu được hiển thị trên các biểu mẫu dạng cột, bảng và
trang dữ liệu.

-43 -

Tài liệu giảng dạy -  Khoa Môi trường, Trường đại học khoa học tự nhiên



Nguyễn Hồng Phương -  Thực hành xây dựng cơ sở dử liệu quan hệ bằng
Access

Bài tập 7. Làm việc vói các biểu mẫu phụ
7.1 ưu điểm của việc sử dụng các biểu mẫu phụ

Khuôn dạng phổ biến được áp dụng để biểu diễn dừ liệu trong các bảng có mối 
quan hệ một - nhiêu là một biêu mâu chính dạng cột (hoặc một cột) kèm theo một biêu 
mẫu phụ dạng bảng. Chẳng hạn, biểu mẫu minh hoạ trên hình 7.1 về thực chất bao gồm 
ba biểu mẫu: biểu mẫu chính chứa các thông tin về một chuyến khảo sát cụ thể; biểu mẫu 
phụ thứ nhất chứa tất cả các trạm đo được thực hiện trong chuyến khảo sát này và biểu 
mẫu phụ thứ hai chứa tất cả các số liệu quan trắc tại mỗi trạm đo.

Trong ví dụ về các bảng Cruise, Station và Observation, các khoá lạ 
(CRUISE_ĨD, STATION_ID) hỗ trợ các mối quan hệ giữa ba biểu mẫu. Sự Hên kết này 
cho phép Access đồng bộ (synchronize) các biểu mẫu, cụ thể là:

• Khi bạn chuyển sang xem thông tin về một chuyến khảo sát khác, chi có các dữ 
liệu trạm đo thuộc chuyến khảo sát mới đó được hiển thị trong biểu mẫu con thứ 
nhất. Đồng thời, ứng với mồi thanh ghi chứa dữ liệu về các trạm đo, chỉ có các số 
liệu quan trắc thuộc trạm đo đang xét mới được hiển thị trong biểu mẫu phụ thứ 
hai;

• Nếu bạn thêm vào một sổ liệu quan trắc mới, trường khoá lạ trong bảng 
Observation sẽ được cập nhật tự độn" (thực ra, việc hiển thị trường 
STATION_ID trên biểu mau phụ là không can thiết).

B8 O ceanographic C ru ise Report (Ç3© ®

OCEANOGRAPHIC CRUISE REPORT________________________________________________

^ Cruise No: n  Vessel: jHMAS Torrens Chief Scientist: | Institute: |A0DC

Location: |Tasman Sea Project Name: |RAN Mk12X8T Program

^  Station No: [Ï Latitude: | -28.85 Longitude: | 160.62 Depth: | 940 Date: | 29-Jan-98

Weather. [SW Wind Speed. | 2 Wind Direction: | Ï55 Air Pressure: | 0 Cloud [4

Time Depth 1 Temp. Salinity Sigma t Oxygen Phospha Nitrate Silicate PH I“
► 10.12 0 29.44 34.366 21.464 4.11 0.08 0.42 0 0

10.12 10 29.46 34.363 21.441 4.15 0 0.44 0 0
10.12 20 29.46 34.375 21.466 4.18 0.08 0.48 0 0
10.12 30 29.53 34.413 21.543 4.19 0.16 0.55 0 0
10.12 50 28.21 34.471 21.949 4.25 0.16 1.14 0 0
10.12 75 25.64 34.535 22.82 3.31 0.65 6.6 0 0
9.10 100 24.51 34.588 23.201 2.68 0 81 10.29 0 0
9.10 150 19.32 34.611 24.661 2.75 1.3 15.84 0 0
9.10 200 13.83 34.625 25.956 2.07 2.11 23.04 0 0
9.10 250 12.02 34.63 26.317 2.03 2.27 20 0 Q-lJ

Record: l < |  | I r  > I H  !►*! of 33

Record: l< I < 11 r » j H  !►*! of 4______________________________________________________

Hình 7.1: Ví dụ về biểu mẫu chính và biểu mẫu phụ.
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• Phần chính của biểu mẫu có dạng cột (mồi trang chứa một thanh ghi) và hiển thị 
thông tin từ bảng Cruise.

• Biểu mẫu phụ thứ nhất cũng có dạng cột và hiển thị thông tin chửa trong bảng 
Station.

• Biểu mẫu phụ thứ hai là một biểu mẫu riêng biệt dạng bảng hiến thị thông tin 
chứa trong bảng Observation.

• Vì mối quan hệ được xây dựng giữa biểu mẫu chính và các biểu mẫu phụ, nên chỉ 
có các dừ liệu có liên quan tới "trạm đo 1" được hiển thị trong biểu mẫu phụ thứ 
nhất và chỉ có các dữ liệu được quan trắc tại trạm đo 1 được hiển thị trong biểu 
mẫu phụ thứ hai.

7.2 Bài tập.
Mặc dù có nhiều cách tạo một biểu mẫu phụ, bạn nên theo quy trình sau đây:

1. Tạo và cất giữ riêng biệt ba biểu mẫu (hai biểu mẫu dạng cột và một biểu mẫu dạng
bảng);

2. Dùng trỏ chuột kéo biểu mầu phụ thứ nhất lên biểu mẫu chính và kéo biểu mầu phụ
thứ hai lên biểu mẫu phụ thứ nhất;

3. Kiểm tra lại mối liên kết giữa hai biểu mẫu.

7.2.1 Tạo biểu mẫu chính

• Sử dụng thuật đồ để tạo một hiểu mẫu mói dạng cột dựa trên hảng Cruise.

• Chỉnh lại vị trí các trường, đưa chúng lên phía trên của biểu mẫu như minh họa trên
hình 7.2.

• Cất giữ biểu mẫu dưới tên gọi frmCruiseReport.

Bước L Sừ dụng thuật đồ để tạo một biểu mẫu mới dạng cột dựa trên bảng Cruise.

Bước 2. Chuyển sang dạng thiết kế biểu mầu và chỉnh lại các hộp văn bản để giành chỗ
chứa đủ biểu mẫu phụ minh hoạ thông tin về các trạm đo (Station Header).

Bước 3. Cất giữ biểu mẫu dưới tên gọi frmCruise Report.

• Để di chuyển nhiều đối tượng của biểu mẫu cùng một lúc, bạn có thể nhấn giữ 
phím Shift khi lựa chọn chúng, hoặc dùng trò chuột kéo một hình chừ nhật bao
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xung quanh các đối tượng mà bạn muốn lựa chọn (nhấn và kéo trỏ chuột để tạo 
hình chữ nhật này).

h72 : Form Đ®®

□I Form Header

OCEANOGRAPHIC CRUlậE REPORT
J #  Detail

CruiseNö; [CRÖl ..... V e s s ĩ  jvESSEL
: Location. |AREA

Ỉ sSjjnfiä]: |CHIEF_SCIENTIST 
*N anie’: jPROJECT.NAME

Hình 7.2: Tạo biểu mẫu chính có giành chỗ cho biểu mẫu phụ.

7.2.2 Tạo các biểu mẫu phụ

• Sử dụng thuật đồ để tạo một biểu mẫu phụ dạng cột và một biểu mẫu phụ dạng 
bảng khác.

• Các biểu mầu phụ được tạo bằng thuật đồ thường đòi hỏi một số thao tác chinh
sửa thêm để chúng không chiếm quá nhiều không gian. Bạn có thể chinh sửa thêm
để biểu mẫu có dạng hoàn chỉnh như minh họa trên hình 7.3.

• Cất giữ biểu mẫu phụ dạng cột dưới tên gọi ỷrmStationHeader và biểu mẫu phụ
dạng bảng dưới tên gọiỷnnStationData rồi đóng chúng lại.

Bước 1. Thu nhỏ vị trí của các nhãn và các hộp văn bản theo chiều ngang.

Bước 2. Giảm kích thước biểu mẫu theo chiều thẳng đứng bằng cách dịch chuyển các 
trường lên trên, về phía nhãn "detail" và kéo phần chân biểu mẫu "form footer" lên phía 
trên (để thay đổi kích thước của biểu mẫu, bạn dùng trỏ chuột kéo các đường viền ranh 
giới biểu mẫu).
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• Để chia phần đầu đề của biểu mẫu thành hai hàng hay nhiều hơn, đặt con trỏ vào 
ranh giới cần chia và nhấn Shift- Enter.

• Để di chuyển cùng lúc tất cả các trường, kéo "hình chữ nhật chọn" sao cho nó bao 
quanh tất cả các trường cần di chuyển.

sy frm S tatlor iH ead er: Form E ® B

- r . .  1 1 . . .  2 . . .  1 ; . . . . . . . • • • 1 • • • ............................. ....  • •

J ♦  Detail
------------------------ 1-------------------------1------------------------- -------------------------1------------------------ 1-------

Station N0, 1 sTAT 101 : Latitude. |lAT U nJ m iL O N G  | ị ị Dep»..;|DEPTH Oste |DATE

: Weather. :|wẺẨTH Wind Speed |WIN0 s' [.Wind DirejDtipnjjwiNblc Ai ipressuie:; jÁlR_PRE : Coud ¡CLOUDY

T 1
::::::::::::: 1:::::::

l i
Hình 7.3: Chỉnh sửa biểu mẫu phụ để tiết kiệm chỗ.

7.2.3 Nối kết các biểu mẫu chính và phụ

Trong mục này, bạn sẽ quay trở lại biểu mẫu chính và kéo biểu mẫu phụ đã cất 
giử từ cửa sổ database tới vị trí thích họp trên biểu mẫu chính.

• Mở biểu mẫu chính (frmCrui.se) trong chế độ thiết kế.

• Chọn Window > CruiseReport: Database để mở cửa sổ database ở phía dưới.

• Kéo biểu mẫu phụ vào biểu mẫu chính.

• Ưu điểm của phương pháp kéo và thả trong việc tạo biểu mẫu phụ là ở chỗ chiều
rộng của điều khiển chứa biểu mẫu phụ (cửa sổ trống màu trắng) sẽ được hiệu 
chỉnh tự động để khớp với chiều rộng của bản thân biểu mẫu phụ đó.

• Nhắc lại thao tác trên cho biểu mẫu phụ Observation.

Nếu sau khi đã tạo điều khiển chứa biểu mẫu phụ, bạn thay đổi kích thước của 
biểu mẫu phụ, bạn cần hiệu chỉnh lại kích thước của điều khiển chứa biểu mẫu phụ bằng 
cách kích trỏ chuột lên một góc khung của điều khiển và kéo cho đến klii đạt được sự ăn 
khớp.
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Bước 1. Mở biểu mẫu chính ở dạng thiết kế.

Bước 2. Chỉnh lại vị trí cùa cửa sổ database để nhìn thấy mục tiêu di chuyển biểu mẫu 
phụ.

Bước 3. Kéo biểu mẫu phụ thả lên biểu mẫu chính.

7.2.4 Nối kết các biểu mẫu chính và phụ bằng tay

Nếu cả biểu mẫu chính lẫn biểu mẫu phụ đều được tạo từ các bảng, và nếu các 
mối quan hệ cũng được xác định giữa các bảng, Access sẽ không gặp khó khăn trong việc 
xác định xem trường nào là trường được dùng để "liên kết" thông tin của biểu mẫu chính 
với thông tin của biểu mẫu phụ. Tuy nhiên, khi các biểu mẫu được xây dựng từ các tra 
vấn, Access sẽ không được thông báo về các mối quan hệ.

Trong trường hợp này, bạn sê phải tự cung cấp thông tin về các liên kết giữa biểu 
mẫu chính và biểu mẫu phụ (hay nói cách khác là cung cấp thông tin bằng tay).

Vì cả hai biểu mẫu được tạo trong mục 7.2.3 đều được xây dựng từ các bảng, 
Access sẽ tự xác định được mối quan hệ.

• Kiểm tra lại quan hệ giữa biểu mẫu chính và biểu mầu phụ trong cửa so property 
của điều khiển chưa biểu mẫu phụ. Các thuật ngữ "link child field" và "link 
master field"  đồng nghĩa với các cụm từ "khoá lạ " và "khoá chính". Biểu mẫu 
chính ứng với phía phụ huynh (hay phía "một") của mối quan hệ, còn biểu mẫu 
phụ ứng với phía con (hay phía "nhiều") của mối quan hệ.

• Hiển thị biểu mẫu kết quả. Chú ý rằng khi bạn lật trang từ chuyến khảo sát này 
sang chuyến khảo sát khác, số trạm đo trong biểu mẫu phụ cũng thay đổi theo 
(xem hình 7.4).

Bước L Chọn điều khiển chứa biểu mẫu phụ StationHeader (cửa sổ trống màu trắng) và 
hiển thị cửa so property của nó.

Bước 2. Kiểm tra xem Access đã xác định chính xác các trường được nối kết hay chưa.
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SE frm C ru lc® R # p o rt1

CO S ơ  D ừ  L IỆ U  CAC CHU YÊN K HAO  S A T  BIEN

Cl IU yến KS Ho n r  Tau |HMAS Torrens

Vung kháo $¿1 I Tasman Sea

K ho j bọc Htròng I

Tẽ« D tfon I RAN Mk12XBT Program

C oquan I AO DC

Thởi tế t |s w  Hướng giô 155

KWidô I 160.6167

TỐCỔỘ06 r

Ngày đo

âp suất không khí Độ mâ/

TIME I DEPTH I TEMPERATURE I SALINITY I SIGMAT I OXYGEN I PHOSPHATE I NITRATE |SIUCATE| P tT
10.12 
10 12 
10 12 
10.12 
10.12 
10 12
9.10
9 .10

0
10
20
30
50
75

100

29.44
29.46
29.46 
29.53 
2821 
2564 
24 51

34.366 
34.363 
34.375 
34 413 
34.471 
34.535 
34,588

21 464 
21 441 
21 466 
21 543 
21.949 

22.82 
23.201

19 32 34G11

Record:

24GG1 

25.956 
26 317 
26 454 
26 719 
26 884

4.11
4.15
4.18
4.19 
4.25 
331 
268 
2 75 
207 
203 
2.02

2
1 99

0 08 
0 

0.08 
0.16 
Ũ.16 
0.65 
0.81 
13 

2  11 
2.27 
2.59 
2.68 
3.08

0 42 
0 44 
048  
0.55 
114 
6.6 

10.29 
1C 04 

23.04 
20 

30 01 
33.65 
33 97

0 
0 
Ũ 

0 
0 
0 
0—' 
a 
0
0 —I

Record: » I »I | > * |  of 4

Hình 7.4: Các biểu mẫu chính và phụ đã được đồng bộ
Bước L Chú ý rằng ứng với chuyến khảo sát số 1, có 33 trạm đo được liệt kê trong biểu 
mẫu phụ. Cũng ứng với chuyến khảo sát số 1, chỉ có 15 điểm quan trắc có số liệu.

Bước 2. Nhấn phím "thanh ghi tiếp theo" trên biểu mẫu chính để xem dữ liệu của chuyến 
khảo sát tiếp theo. Có ba bộ phím cho phép thực hiện các thao tác chuyểéoang thanh ghi 
tiếp theo: một ứng với biểu mẫu chính Cruise (nằm dưới cùng màn hình), một ứng với 
biểu mẫu phụ Station và một ứng với biểu mẫu phụ Observation.

7.2.5 Tinh chỉnh

Trong mục này, bạn sẽ thay đổi các tính chất của một vài đổi tượng của biểu mẫu 
(và của cả biểu mẫu) để khiến cho biểu mẫu của bạn có hình thức đẹp hơn và dễ sử dụng 
hơn.

7.2.5.1 Thay đổi chú thích của biểu mẫu

• Chọn biểu mẫu như minh họa trên hình 7.5.

• Đổi phần chú thích (Caption) của biểu mẫu thành "Oceanographic Cruise 
Report”.
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.  o  X

♦  Form Header

CO s ò  Dừ ị-iậu  CAC ÕmŨỸỊe n  k h a o  s a t Ịsién

♦  Detail

• I.» T«| | ữ ũ  I..M |VESSEL ■ KI<M :) |CHIEF.SCIENTIST

[AREA T v li lN f ii  |PRQJECÍ_NAME

«3 Form

|Form “ 3

Format | Data | Event | Other AH

Record Source.................... . Cruise
F ilte r...................................
Order B y ............................
Allow Filters....................... . . Yes
Caption.............................. . . J>:eanographic Crue
Default View....................... . . Sngle Form
Allow Form View.................. . Yes
Allow Datasheet View . Yes
Allow PivotTable View . Yes
Allow PivotChart View . Yes
Allow E dits......................... . . Yes
Allow Deletions................. . . Yes
Allow Additions.................. . . Yes
Data E n try ......................... . . No
Recordset Type .................. . Dynaset
Record Locks....................... . No Locks
Scroll Bars............................ . Both

inn«  [long » a t t iị [depth -  |:Nga> do |DAIE

« 9»  ịWIN0_SP€E[ âpsuáỊhhOnạkN |AIR.PRESS M n Ị Ị  |CLŨUDY

• r 1

Hình 7.5: Thêm vào một chú thích cho biểu mẫu

7.2.5.2 Loại bỏ các thanh cuộn và các phím di chuyển không cần thiết
Các thanh cuộn và các phím di chuyển cũng là các tính chất mà ta có thể xác lập 

cho biểu mẫu. Tuy nhiên, trong trường hợp này, bạn cần hiệu chỉnh các tính chất của biểu 
mẫu phụ Statỉon Data.

• Kích đúp trỏ chuột lên điều khiển chứa biểu mẫu phụ trong khi hiển thị biểu mẫu
chính ở dạng thiết kế đề mở nhanh biểu mẫu phụ cũng trong dạng thiết kế;

• Hiển thị cừa sổ property của biểu mẫu chính và cuộn xuống dưới tới các tính chất
Scroll Bars và Navigation Button như minh họa trên hình 7.6.
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Nguyễn Hồng Phương -  Thực hành xây dựng cơ sở dữ liệu quan hệ bằng
Access

-
y ¡ 0 ®

♦  Detail

TIME ỊịịDEPTH : JATURE [jÑ ÍTY  : |GMA_T ịịíxrG EN  :|PHATE I TRATE Ị |L- c a t  é

fe Form

[Form

Format | Data Event Other All

Order B y ............................ , , /V

Allow F ilters ....................... . . Yes
Caption............................... . . Station Data Form __
Default V iew....................... . , Datasheet
Allow Form V iew .................. . Yes
Allow Datasheet View . Yes
Allow PivotTable View . Yes
Allow PivotChart View . Yes
Allow E d its.......................... . . Yes
Allow Deletions.................. . . Yes
Allow Additions.................. . . Yes
Data E n try .......................... . . No
Recordset T ype .................. . Dynaset
Record Locks....................... . No Locks
Scroll B a rs ............................ . Vertical Only
Record Selectors............... . . Yes
Navigation Buttons............. • 20 V

____

Hình 7.6: Change scroll bars and navigation buttons of the subform.

Bước 1. Xác lập tính chất Scroll Bar thành "Vertical Only" (chi theo chiều thẳng đứng) 
và tính chất Navigatỉon Buttons thành "No" (Không).

Kết quả cuối cùng nhận được là một biểu mẫu có hình thức đẹp và không qua 
srườm rà.
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